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About This Manual

This manual explains how to use TopDraw, the object-oriented
graphics program for the Apple IIGS. Chapter One, "Before You
Begin," explains what you need to know and what equipment you
need before starting up your TopDraw program disk. In addition,
it explains what object-oriented graphics are, how they differ from
bit-mapped graphics, and how this difference benefits you.

Chapter Two, "Learning TopDraw," begins with an introduction
to the basic elements of the TopDraw environment and explains in
detail each of the tools you'll use in creating drawings. The
second half of this chapter consists of a self-paced tutorial lesson,
which shows you how to use many of TopDraw's graphics tools
to create a sample party invitation.

Chapter Three, "Using TopDraw," provides detailed instructions
for creating and modifying various shapes, patterns, and colors.
This chapter includes step by step instructions for each major
drawing task you can perform with TopDraw. If you're familiar
with object-oriented graphic programs, you may want to skip
Chapter Two and continue with this chapter.

Chapter Four, "TopDraw Reference," contains a summary of all
the tools, menus, and commands in TopDraw. This chapter also
includes a list of the original TopDraw program defaults, and
instructions for installing TopDraw on a hard disk drive. Refer to
this chapter when you need a detailed description of a particular
TopDraw command or if you need to know about the preset
program options.

This manual concludes with a Glossary, which contains
definitions of important terms used throughout the manual, and a
special Quick Reference Card which you can place beside your
computer as you use the program.
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Introduction

This chapter will give you an understanding of what you'll need to
begin using TopDraw. There's an explanation of what hardware
you'll need, as well as some concepts which you'll want to
understand before using TopDraw. Finally, there's an explanation
of object-oriented drawing, the shape-based illustration

system used by TopDraw, as well as a discussion of the
advantages of object-oriented graphics over conventional
bit-mapped "paint" programs for extensive graphic work.
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Getting Started

System
Requirements

Backups

There are many ways to learn how to use TopDraw. The method
with which you feel most comfortable is obviously the best one,
but we'd like to recommend that at some point you carefully read
the entire TopDraw manual. Here are several methods that you
may choose:

® Read the entire manual, making note of the important
features of TopDraw.

® Read Chapter One, "Getting Started,”" and Chapter Two,
"Learning TopDraw."

® Use your knowledge of another object-oriented drawing
program to understand the basic concepts in TopDraw.

® Start experimenting on your own. (Many people enjoy this
almost as much as a good game program.) Be sure,
however, to refer to this manual if you have any questions.

To use TopDraw, you'll need an Apple IIGS with a monitor and a
mouse, a 3.5-inch disk drive, and at least 512K of memory.
Memory expansion cards from a number of manufacturers can be
used to increase the amount of memory available for use with your
Apple IIGS. TopDraw can take advantage of any additional RAM
(beyond the minimum requirement of 512K) that you've installed
in the memory expansion slot of your IIGS, allowing you to

create larger documents. Be sure that the speed option on your
IIGS control panel is set at Fast to ensure that TopDraw runs at its
optimum operating speed.

Because TopDraw is copy-protected, you may want to obtain a
backup copy of the program. You can get a backup of TopDraw
for a small fee by contacting StyleWare at either of the product
order phone numbers listed in the inside back cover of this
manual. Both protected and unprotected backups are available to
registered TopDraw owners.
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Things to Know

Using the Mouse

ProDOS 16

Important Terms

There are several things that you'll want to know to use TopDraw
to its full potential:

It's essential that you understand how to use the mouse to use
TopDraw. If you haven't read your Apple IIGS Owner’s Manual,
be sure to read it before using TopDraw. Also, it will be helpful
for you to read your Apple 1IGS System Disk User’s Guide. To
learn all about using the Apple IIGS mouse, run the tutorial disk
that came with your Apple I1IGS (Your Apple Tour of the Apple
IIGS ), or run the mouse tutorial program on the MousePaint disk
that comes with the AppleMouse II. You'll want to be sure to
understand basic mouse operations such as pointing, clicking,
and dragging.

To use the file management features of TopDraw most effectively,
you'll want to have a working knowledge of ProDOS 16, the disk
operating system under which TopDraw runs. To clearly
understand ProDOS 16, be sure to read your Apple IIGS System
Disk User's Guide.

Before using TopDraw or reading this manual further, it's
important that you understand several familiar words that are being
used in this manual in specific ways with regard to TopDraw.

An object is any shape drawn with any of TopDraw's tools.

These shapes may be ovals, rectangles, rounded rectangles, lines
— even text. TopDraw regards all objects as geometric figures,
which is what allows you to move, reshape, duplicate, group,
lock, and delete objects; it also allows you to overlay objects by
placing one object on top of another. TopDraw can always
remember the shape of an object (and therefore quickly redraw the
object) because the shape is defined as a mathematical "formula."

A document is any drawing that you create at one time with
TopDraw.

A command is any instruction you give your Apple IIGS which
causes it to perform a specific task. In TopDraw, you execute
commands by choosing them from pull-down menus or by
typing keyboard equivalents, key combinations which, when
pressed, perform the same task as choosing a command from a
menu.

S Before You Begin



If There's a Problem
With Your TopDraw
Disk

Object—Oriented
Drawing

In rare instances, there may be a physical problem with your
TopDraw disk. If you suspect that such a problem has occurred
with your TopDraw disk, contact StyleWare's Technical Support
Department at the number listed on the inside back cover of this
manual.

Everything that you draw in TopDraw is in the form of objects,
mathematically defined shapes which can be manipulated more
precisely and effectively than the bit-mapped graphics of paint
programs, which create images by allowing you to change the
color of individual dots on the computer screen.

The shapes you draw with bit-mapped graphics programs are
comparable to free-hand drawings that you produce with a pen or
paint brush, with dots on the screen as your paint or ink. There

are limitations to this approach: for example, if you cut out a shape
in a bit-mapped program, a hole appears where the shape had
been; if you change a shape in a bit-mapped program, you can't
easily restore the shape to its former dimensions.

Object-oriented graphics, on the other hand, can be compared to
cutting out pieces of paper and combining them to form drawings,
except that with TopDraw, your drawings can be much more
detailed than if you used scissors, construction paper, and glue.
An object may be a line, rectangle, oval, arc, polygon, text, or a
freehand shape. Any of the drawing tools that you use will create
an object, and many of the commands in the menus will allow you
to edit or change the object. Once an object has been created, it
can be reshaped, resized, and duplicated quickly and easily; you
can change the width of its border and its color and pattern with
just a few mouse clicks.

You're now ready to begin learning and using TopDraw. The
next chapter, "Learning TopDraw," shows you how to start up
TopDraw, explains the TopDraw drawing environment, and
includes a short tutorial lesson to make sure you understand the
basics of creating graphics with TopDraw. Chapter Three, "Using
TopDraw," provides step by step instructions for using
TopDraw's many powerful graphic-editing features. If you have
questions about using a specific command, refer to Chapter Four,
"TopDraw Reference."
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Introduction

Chapter Two will familiarize you with the basic concepts that
you'll need to know to use TopDraw. If you've used MacDraw™
or another object-oriented drawing program, then you may already
know some of the concepts involved in using TopDraw. This
chapter will make sure that you know about the TopDraw
environment and how to use all of TopDraw's powerful drawing

tools, and then guide you along step by step as you create your
first drawing with TopDraw.
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Starting TopDraw

To start TopDraw, you'll first open it from the Program Launcher.

B Insert the TopDraw disk, metal end first and
label side up, into your 3.5-inch disk drive.

B Turn on your Apple lIGS and your monitor.

The Apple 1IGS Program Launcher appears. You'll use the
Program Launcher to open TopDraw.

B Click the program name "TopDraw" to choose
it from the list in the Program Launcher dialog
box.

B Click Open.

The desktop clears, temporarily replaced by a blank screen
titled "/StyleWare. TD/TopDraw." After a few moments, this
screen clears and the TopDraw desktop appears.

10 Chapter Two



The TopDraw
Desktop

The menu bar contains
the names of the pull-down
menus from which you
choose commands.

The tool palette

contains ten tool icons that
let you choose the tools you
need to create different types
of objects.

The TopDraw desktop contains the tools that you'll use to create
colorful drawings in the document window. The document
window is the area in which you can draw with TopDraw.

Fileg Edit View Arrange Font Style Options Windows

ntitled

The document window

is the area in the TopDraw
screen in which you create
drawings.

The line palette

contains a number of
different line widths from
which you can select line
sizes for the outlines of your
objects.

The pattern palette
contains the color patterns
that you can use to draw and
fill your objects.
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The Document
Window

The title bar ——_——/
The close box

The title

[EN=————=—=—=ntitied

The zoom box

The scroll bars

The size box

EO=untitied EAE|

= untitled =0

The Title Bar

The title bar is the rectangular area at the top of the document window that
contains the name of your document, or "Untitled" if the document hasn't been
named.

The Title

The title is the name you give to a document; it appears in the center of the
title bar. If you've not yet named your document, the document's given the
name "Untitled." It's not a good idea to actually name a document "Untitled,"
because you might not know if the document has been saved or not.

The Close Box

The close box, located on the left side of the title bar, is used to tell

TopDraw to put the current document away without having to choose Close
from the File Menu. Clicking the close box closes the document and clears

the document window from the TopDraw desktop. If you've made any unsaved
changes, TopDraw will let you save the changes before closing the document.
Clicking the close box is identical to choosing Close from the File Menu.
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The Zoom Box

The zoom box, located on the top-right side of the title bar, is used to

toggle between the regular size of the document window and a full-screen view
of the document that you're working on. Click on the zoom box and the
document window expands to cover the entire screen; click on it again and the
document window contracts to its regular size.

Scroll Bars

To see the part of your document that's not currently on the screen, you'll use
the scroll bars located on the right and bottom sides of the document
window.

To scroll a document, just press the scroll arrow that corresponds to the
direction in which you'd like to "move" the document window over your
document. The white area of a scroll bar, called the scroll box, will move

in the direction that you press. Each scroll box represents the part of the
document currently displayed in the document window, and shows you its
proportional size and position relative to the entire document, which is
represented by the entire scroll bar (which includes the grey area as well as the
scroll box).

The Information Bar

If you've chosen the Show Document Info command, you'll see a box called
the information bar at the top of the document window that indicates the
current number of objects in your document, the number of selected objects,
the amount of free memory in your computer, and the current view scale of
your document.

The Size Box

The size box, located on the lower-right side of the document window, is
used to allow you to change the size of the document window. By dragging
the size box, you can increase and decrease the height and width of the
document window.

13 Learning TopDraw



The Tool Palette
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The tool palette is the group of ten symbols or icons that you

see on the upper-left side of the TopDraw screen. You'll use these
tools to create objects that you can then combine to form
drawings. By mastering the use of each of the different tools,
you'll become familiar with the best ways to use them.

You can move the tools anywhere on the screen by placing the
arrow pointer tool on the edge of the tool box and then dragging
the palette to the desired location on the screen.

The Arrow Pointer Tool

The arrow pointer tool, or selection pointer, is the tool that's active when
you start up TopDraw. You can use the arrow pointer tool to select, resize, or
drag objects.

The Text Tool

The text tool allows you to place words in your TopDraw documents by
creating text objects.

When you select the text tool, the pointer changes to an I-beam pointer,
which you can place anywhere in the document window. To type text,
position the pointer and then click the mouse button. A blinking vertical bar,
called the insertion point, will appear, allowing you to type in text. When
you finish typing, select any other tool, press return, or click the pointer
elsewhere on the document and the insertion point will disappear. Text may
be in one size, one font, and any combination of styles.

Text objects are much like other objects, except that the line pattern must be a
solid color pattern to affect the text color. If you select a line pattern that is
not a solid color pattern, the text color will be set to the color of the upper left
pixel of that pattern as it appears in the pattern editor. Fill patterns affect the
background behind the text. Neither the fill nor the line pattern of a text
object can be the None pattern.

14 Chapter Two



The Horizontal/Vertical Line Tool

The horizontal/vertical line tool lets you create lines that are always parallel
with the horizontal and vertical edges of the drawing window. Like all shapes
drawn with TopDraw, these lines are objects.

To draw horizontal or vertical lines, first select the horizontal/vertical line
tool. Next, press and hold the mouse button at the place in the document
where you'd like to start the line, drag the mouse (holding the button down) to
the place where you'd like the line to end, and release the mouse button. The
lines that you draw will be constrained to either the vertical or horizontal axis,
depending on the direction in which you choose to draw. You can resize a
horizontal or vertical line by selecting it and dragging one of its endpoints.

The Line Tool

With the line tool you can draw straight lines at any angle. These lines will
be created as objects in your documents.

To draw diagonal lines in your document, first select the diagonal line tool.
Next, click the mouse button at the point in the document where you'd like to
start the line, drag the mouse (holding the button down) to the place where
you'd like the line to end, and release the mouse button. You can edit a line
by selecting it and then dragging one of its endpoints.

You may constrain the line to either 45 or 90 degrees by holding down the
shift key as you draw.

The Rectangle Tool
The rectangle tool allows you to draw squares and rectangles.

To draw squares or rectangles in your document, select the rectangle tool, then
press and hold the mouse button at the point where you'd like to place one of
the comners of the rectangle. Holding down the mouse button, drag to the
point where you'd like to place the diagonally opposite corner, and release the

mouse button. You can edit a box by selecting it and then dragging any of its
handles.

You may constrain a rectangle to a square by holding down the shift key as
you draw.

1S Learning TopDraw



The Rounded Rectangle Tool

The rounded rectangle tool lets you draw squares and rectangles with rounded
corners.

To draw a rounded rectangle in your document, select the rounded rectangle
tool. Next, press and hold the mouse button at the place where you'd like to
place one of the corners of the box. Drag the mouse (holding the button
down) to the place where you'd like to place the diagonally opposite corner,
and release the mouse button. You can resize and/or reshape a rounded
rectangle by selecting it and then dragging any of its handles in the appropriate
direction.

You can change the roundness of the corners of a rounded rectangle (before or
after drawing it) by using the Corner Radius command.

You may constrain a rounded rectangle to a rounded square by holding down
the shift key as you draw it.

The Oval Tool

With the oval tool you can draw circles and ovals as objects in TopDraw
documents.

When drawing ovals in your document, keep in mind that ovals, when being
drawn, act as if they were invisible rectangles containing ovals. To draw an
oval, first select the oval tool, and then press and hold the mouse button at the
place where you'd like to place one of the "corners” of the oval. Drag to the
place in the document where you'd like to place the opposite (diagonal)
"corner" and release the button. You resize and reshape an oval by selecting it
and then dragging any of its handles.

You may constrain an oval to a circle by holding down the shift key as you
draw.
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The Arc Tool
The arc tool lets you draw arcs, which are portions of ovals and circles.

To draw 90 degree arcs (quarter circles or ovals) in your document, select the
arc tool and then press and hold the mouse button at the place where you'd like
to place the starting point of the arc. Drag to the place in the document where
you'd like to place the endpoint of the arc, and release the mouse button. You
can edit the size and curvature of an arc by selecting it and then dragging any
of its handles. You can also edit the number of degrees an arc spans by
selecting the arc and then choosing the Edit Arc Angles command. You can

then make the changes by dragging one of the handles on the endpoints of the
arc in a circular motion.

If you fill an arc with a pattern other than None, it will produce a pie,piece—
like object that has a border only on its curved part.

You may constrain an arc to a quarter circle by holding down the shift key as
you draw.

The Polygon Tool

The polygon tool allows you to draw objects that have any number of
vertices.

To draw polygons in your document, select the polygon tool. Next, press and
hold the mouse button at the point where you'd like to place the starting point
of the polygon's first line. Drag the mouse to the point where you'd like to
place the ending point of the first line and click the mouse button. Move the
mouse to the place where you'd like the second line to end and again click the
mouse button. Continue in this manner until you're finished with the object.
You can end the object at any time by double-clicking at any one point, by
clicking outside the document window, or by placing the last point on top of
the starting point. You can edit the size of a polygon by selecting it and then
dragging any of its handles, or edit its shape by selecting it and then choosing
the Edit Polygon Points command from the Edit Menu.

You may constrain the lines of a polygon to either 45 or 90 degrees by
holding down the shift key while you draw the lines.

17 Learning TopDraw



The Freehand Shape Tool

The freehand shape tool lets you draw objects without any shape limitations,
and without any guides (such as the grid) by which to draw them.

To draw free-form shapes in your document, select the freehand shape tool and
then move the pointer to the place in the document where you want to start

the object. Press and hold the mouse button as you draw the object. When
you're finished drawing the shape, release the mouse button. You can edit the
size of a freehand object by selecting it and then dragging any of its handles, or
edit its shape using the Edit Polygon Points command.

18 Chapter Two



The Line
Palette

The line palette is the rectangular area on the lower-left side of
the TopDraw desktop which contains seven lines of varying
thickness and a box containing a line with arrowheads on either
end (the arrowhead selection box). By selecting these lines (the
currently selected line is indicated by the check mark), you can
change the line size of the objects that you draw. You can also use
the line palette to add arrowheads to the ends of the lines of the
objects that you draw by selecting arrowheads in the arrowhead
selection box.

You can move the line palette anywhere on the screen by placing
the arrow pointer tool on the edge of the line palette and then
dragging the palette to the desired screen location.

Line Size

Each of the line sizes in the line palette can be selected by clicking on the
desired line. When an object is selected (see "Selecting Objects,” p.21), a
check mark appears in the line palette beside the line size of the object. If
several objects with varying line sizes are selected, or if the object's line size
has been edited with the Line Size command to create a non-standard line size
(one not offered in the line palette), the check mark will disappear. For more
information on changing line size, see "Line Size...", p. 150.

Arrowheads

The box containing a line with arrowheads on both ends is the arrowhead
selection box. To add arrowheads to the lines of any open object

(objects that have two endpoints that don't overlap), click either the left or
right arrowhead. Selecting the left arrowhead will add arrowheads to the
left side endpoints of selected objects; selecting the right arrowhead will add
arrowheads to the right side endpoints of selected objects; selecting both
arrowheads will add arrowheads to both endpoints.

To add arrowheads to a previously drawn object, just select that object and then
use the arrowhead selection box.
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The Pattern
Palette

The pattern palette contains the patterns with which you'll draw
your objects. With the tools in the pattern palette, you can change
the fill and line patterns that your objects use.

You can move the pattern palette anywhere on the screen by
placing the arrow pointer tool on the edge of the pattern palette and
then dragging the palette to the desired screen location.

Patterns

Each of the boxes in the pattern palette contains a pattern that you can use as
either the line pattern or the fill pattern of any object. You can edit the
patterns in the pattern palette by choosing the Edit Patterns command or by
double-clicking on any of the patterns in the palette. Selecting None means
you're choosing no fill pattern; objects created or selected when you choose
None will therefore appear transparent.

Colors

The solid colors on the pattern palette are actually patterns made up of dots of
only one color. The more multicolored patterns you use, the fewer solid color
patterns you'll have in the palette.

The Pen Icon

The pen icon allows you to choose the line pattern for any object that you
might draw.

To change the line pattern of an object, place the pointer over the pen icon and
drag it to the pattern that you want to use as a line pattern, or click on the

left side of the square of the pattern that you want to use. The pen icon will
automatically jump to that pattern.

To change the line color of a previously drawn object, select that object and
then move the pen icon to the pattern that you want to use.

The pen icon cannot be placed on the None pattern. If you'd like to draw an
object with no line pattern, choose the dotted line in the line palette.
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Selecting Objects

[A]

Overlapping
Objects

The Paint Bucket Icon

The paint bucket icon lets you choose the fill pattern for any object that you
might draw.

To change the fill pattern of an object, place the pointer over the paint bucket
icon and drag it to the pattern that you want to use as a fill pattern, or click on
the right side of the square of the pattern that you want to use (or click
anywhere on the None box). The paint bucket icon will automatically jump
to that pattern.

To change the fill pattern of a previously drawn object, select that object and
then move the paint bucket icon to the pattern that you want to use.

To manipulate or edit an object that you've drawn, you must first
select it. You can select an object by clicking on it with the arrow
pointer tool or by surrounding it with a selection box (selection
boxes are explained later in this Chapter and in Chapter Three).
You can select several objects at once by surrounding them with a
selection box or by holding down the shift key as you select the
objects one at a time.

A selected object can be identified by its handles, the small square
blocks that appear at the ends of lines or around the perimeters of
other objects. A selected object is affected by any changes made
with the menus, the line palette, the pen icon, or paint bucket icon.
When you select an object, the pen and paint bucket icons on the
pattern palette move to the line pattern and fill pattern of that
object, and the check mark moves to the object's line size in the
line palette, if the object uses a standard line size (otherwise, no
check mark appears in the line palette).

Any new object that you draw will be at the topmost layer of
objects, and will appear in front of any other object that's in the
same space. In other words: objects, just like cut-out pieces of
paper, can overlap. You may change the "level" of an object using
the Bring to Front, Send to Back, Shuffle Up, or Shuffle Down
commands.
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Pull-Down Menus
and Keyboard
Commands

| % Fie Edit view Arre:

Rulers

Ruler Lines

Like other applications for the Apple IIGS, TopDraw uses
pull-down menus to let you choose commands.

H Pull down the Edit Menu.

While you have the Edit Menu pulled down, notice that some
of the commands have characters displayed to their right.

These are called keyboard equivalents to pull-down menu
commands because they let you use certain key combinations to
perform the same tasks as their menu commands.

In TopDraw, keyboard equivalents are also called C-key
commands, because you press the 3 key in conjunction with
another key to perform a task that you'd normally pull down a
menu to execute. To perform the Cut command without
pulling down the Edit Menu, for example, you'd hold down
the &% key and at the same time press the X key; this command

is represented on the Edit Menu by (5X. Pressing (tX, then, is
equivalent to choosing Cut from the Edit Menu.

The rulers in TopDraw allow you to draw with precision and to
measure objects and distances on the TopDraw screen. The

rulers, which you can display by choosing Show Rulers from the
Options Menu, will appear on the upper and left sides of the
document window. Small lines will move through the scales of
the two rulers as you move the mouse pointer, indicating both the
horizontal and vertical positions of the pointer. Using the Edit
Rulers command, you can change the increments of the rulers (and
set the scale markings to English or metric) to work best with the
drawing that you're working on.

The ruler lines, which are the small grey lines that form a grid in
the document window, help you align objects quickly. The ruler
lines can also help you know the current view scale (See "View
Menu" in Chapter Four, "TopDraw Reference") of your drawing.
As you zoom closer into your document, the ruler lines will appear
farther apart, indicating that you're closer to the page.
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An Invitation
Design

The best way to learn something is to do it, so let's learn about
TopDraw by creating a drawing. In this way, you'll learn about
most of the tools and techniques needed to produce a drawing by
actually using them. The drawing that you'll make doesn't include
all of the features of TopDraw, so be sure to check Chapter Four,
"TopDraw Reference" to learn about all of TopDraw's features.

For your first drawing, let's create an invitation to a party.
(Because you'll be doing so much good work with TopDraw, you

might as well throw a party to celebrate your new-found
creativity!)

The first thing that you'll need to do to create your invitation is
draw an outline for it. To make sure that it's an appropriate size,
you'll want to use the rulers.

B Choose Show Rulers from the Options Menu.
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@ H Select the rectangle tool from the tool palette.

B Use the rectangle tool to draw a rectangle
about 5 inches wide by 3 inches tall.
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Now let's draw a fancy border for your invitation.

@ H Select the rounded rectangle tool from the tool
box.

........... H Select the thickest line (the one at the bottom
of the line palette) from the line palette.

— This will ensure that the border is wide enough to be seen
— well.
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B Using the pen icon, select your favorite line
pattern from the pattern palette.

B Use the paint bucket icon to select a suitable
background (fill) pattern for the invitation.

You should choose a solid-color pattern so that the text will be
legible.

B Use the rounded rectangle tool to draw a
rounded rectangle within the outline that
you've drawn.
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Now let's draw a gift box.

H Select a small line size for the gift box.
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H Select an appropriate fill pattern for the gift
box.

H Use the rectangle tool to draw an appropriately
sized gift box on the left side of the invitation.

Now let's add a ribbon to the gift box.
B & H Select a different line and fill pattern.

@ H Use the rectangle tool to draw a thin rectangle
inside the gift box.
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Now that you've wrapped your gift, let's put a bow on it.
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B Select the oval tool and draw a set of three
overlapping ovals at the top of your box.
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Since the ovals will probably overlap the box a little, let's bring
the box back to the front of the drawing so that the bow appears
to be on top of the box.

H Select the arrow pointer tool.

M Place the arrow pointer on the gift box and
click the mouse button.

Handles appear around the gift box, indicating that it's
selected. Clicking on an object with the arrow pointer tool
selects an object. Once an object's selected, you can change it
or execute a command to affect it in some way.

H Holding down the shift key, select the ribbon.

Holding down the shift key while selecting allows you to select
more than one object at once.
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B Choose Bring to Front from the Arrange Menu.
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The gift box and its ribbon are placed on top of the bow,
creating the illusion that the bow is on top of the box.

Now that you've got a gift, let's make sure we know who it's
for! Add a string on which to place a name tag.

B Select the freehand tool from the tool palette.

B Select the black line pattern and the None fill
pattern.

B Use the freehand tool to draw a string that

hangs down from the bow to about half of the
height of the box.

28 Chapter Two



o File Edit View Arrange Font Style Options Windows

e

Now let's add the name tag.
l Select the polygon tool from the tool box.
You'll use the polygon tool to create a diamond-shaped tag.

B Select a white fill pattern with a black line
pattern.

B Place the crossbar pointer on the string and
click the mouse button.

The place where you clicked becomes the first point in the name
tag polygon.

B Drag the crossbar pointer to the place where
you want to put the next point in the polygon.

As you drag, a line forms between the place where you clicked
and the crossbar pointer; this is the first side of the polygon.

M Click the mouse button again.

The place where you clicked becomes the second point in the
name tag polygon.
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B Continue to drag the crossbar pointer and click
the mouse button to create the next two points
(and the next three sides) in the polygon.

B When you're done, click on the starting point of
the polygon.

There's no real reason you should settle for just one gift, is
there? To easily make a similar gift box, all you need to do is
duplicate the one you've already created and make minor
changes to it.

To do this, you'll want to select all the objects which make up
the gift box. You've already seen how to select multiple objects
simultaneously by holding down the shift key and clicking on
each object individually. This works fine for one or two
objects, but if you have a larger number of objects to select,
TopDraw offers an even easier method for selecting: drawing a
selection box around the objects.

l Place the arrow pointer tool inside the
document window but outside and to the left of
the rounded rectangle.

30 Chapter Two



B With the arrow pointer above the objects to be
selected, press the mouse button.

B Holding down the mouse button, drag
diagonally across the objects to be selected.

As you drag, a dotted rectangle — a selection box — appears.
All objects surrounded by the selection box when you release
the mouse button will be selected. Be sure to surround only the
objects making up the gift box, and not the rounded rectangle.

B When the selection box completely covers the
objects to be selected, release the mouse
button.

All the individual objects making up the gift box are selected.

B Choose Group from the Arrange Menu.

The entire gift box becomes one object! You'll use the Group
command whenever you want to treat a number of objects as a
single object.

B With the gift box object selected, choose
Duplicate from the Edit Menu.

A copy of the gift box appears on top of the original.

EDEJFH:H:IEGEEE'
Ili|||2|l|3|l|4|||5||l$|lL?H}

31 Learning TopDraw



Now let's make the second gift box look different from the
original. Since the duplicate gift box is already selected, you'll
just reshape it by dragging its handles.

H Change the duplicate gift box to a smaller size
by dragging one of its corner handles closer to
the inside of the object.

H Now place your second gift box right in front of
the first one.
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So that all your friends will know where your party's being
held, you'll need to add some text to the invitation to tell them.

B Choose the text tool from the tool box.

The pointer changes from the arrow pointer to the I-beam
pointer.

B Place the pointer above the gift box, just inside
the upper border.

B Click the mouse button.

A blinking vertical bar, called the insertion point, appears in
the document window.
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B Type" Party at Bob's House."

H Now use the I-beam pointer to reposition the
insertion point, click the mouse button, and
type something about what time you want to
hold your party.
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The last thing you'll want to do is add some blank lines where

you can write in the name and address of each person to whom
you wish to send an invitation.

M Choose the horizontal/vertical line tool from
the tool box.

H Draw three horizontal lines alongside the gift
box that you've drawn.
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Now that you've created a masterpiece, you'll want to save it to
disk so that you can retrieve it later.

B Choose Save As from the File Menu.

A dialog box appears. The Save As dialog box contains a list of
the files and directories on the disk and an input bar where you
can type in the name under which you wish to save your
document. If you haven't specified a name, this box contains
the name "Untitled," which is highlighted (indicating that it's
selected) so that you can give it a new name by just typing.

B Type a name for your document.
The new name appears in the input bar.

B When you've finished typing a name for the
document, click the Save button.
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TopDraw saves the document on disk, and the new name
you've given it appears in the title bar.

Now you'll want to print your invitations so that everyone will
know about the party.

Before you print the first time, you have to tell TopDraw which
printer and printer port you're using with the Choose Printer
command.

B Choose Choose Printer from the File Menu.

When you choose the Choose Printer command, a dialog box
appears with lists for specifying your Printer and Printer Port.

H Click the name of your printer in the Printer
type list.

If necessary, scroll the list until the name of your printer
appears.

B Click the name of the printer port you're using
from the list of printer ports.

If necessary, scroll the list until the name of the printer port
you're using appears.
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B Click OK or press return.

Your printer setup specifications are saved on your TopDraw
disk.

The next step in printing a document is to use the Page Setup
command to tell TopDraw what size paper you're using and
how you want your drawing to appear on the printed page.

B Choose Page Setup from the File Menu.

The Page Setup dialog box appears. The Page Setup dialog box
differs depending on whether you're using an Imagewriter,
Imagewriter II, or LaserWriter.
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The dialog box contains Page Setup options for four different
standard paper sizes, special effects (such as 50% reduction
and no page feeds between pages), and orientation of print on
the page (vertical — portrait — or sideways — landscape

— printing). These options are preset to the settings displayed
above. You'll probably want to use these settings, unless
you're using a paper size other than US Letter, in which case
you'll just want to click on the setting for the paper size you're
using.

B Click OK to confirm these option settings.

You're almost ready to print! All you have to do now is tell
TopDraw how you want your invitation printed.

H Choose Print Normal from the File Menu.

The Print dialog box appears, offering options that let you
specify how you want your document printed. The Print dialog
box differs depending on whether you're using an
ImageWriter, ImageWriter II, or LaserWriter. The instructions
below assume you're using an ImageWriter/ ImageWriter II;

if you're using a LaserWriter, see "Print Normal" in Chapter
Four, "TopDraw Reference."

37 Learning TopDraw



B Click on the Better Color print quality setting.
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Your invitation will be printed with the highest quality dot
matrix printing offered by TopDraw.

B Click on the Copies input bar and type "3."
With TopDraw you can print multiple copies of any document.
Now let's tell TopDraw that you want to print in color.

B Click on the Color check box.

An "X" appears in the Color check box, indicating that color
printing is selected.

B Click OK or press return to confirm these
option settings.

The invitation begins to print. When you're done, three copies
will be printed.
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TopDraw remembers the print settings you specify and confirm
for a document, so that you don't have to adjust the print
specifications each time you print. Whenever you start up the
program or create a new document with New, the print option
settings will be the preset options shown above.

Congratulations — you've learned the basics of creating
graphics with TopDraw! You'll probably want to experiment
with TopDraw a bit to become more comfortable with the
program. When you're ready to quit, follow the instructions
below.

B Choose Quit from the File Menu.

TopDraw quits and returns to the Program Launcher.

If you've made additional changes to your document since you
saved it, or if you opened a new document with New, a dialog
box appears to let you save your changes before quitting.

The next time you start up TopDraw, take a look at Chapter Three,
"Using TopDraw." This chapter explains in detail all the different
graphic processing features TopDraw offers. If you're interested
in using TopDraw to do a specific drawing task, look at Chapter
Three's Table of Contents or consult the Index at the end of the
manual. If you have questions about a specific command — Save
As, for example — refer to Chapter Four, "TopDraw Reference."”
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Chapter Three explains how to use most of the features of
TopDraw by providing step by step instructions on the basic
TopDraw operations. Refer to this chapter as you use TopDraw if
you have questions about performing a particular task. For more
information on individual commands, refer to Chapter Four,

Working with Entire Documents
Changing the Document Size
Changing the Document Scale
Editing the Colors

Editing the Patterns

Using Rulers

To Show Rulers

To Hide Rulers

Editing the Rulers
Displaying the Ruler Lines
Hiding the Ruler Lines
Turning the Grid On
Turning the Grid Off

Restoring the Program Defaults

Changing to a Set of Custom Defaults

Working with Document Files
Opening an Existing Document
Creating a New Document

Loading Bit-Mapped Pictures into TopDraw

Saving Documents
Printing Documents
Closing Documents
Quitting TopDraw

"TopDraw Reference.”
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Drawing

The different tools in TopDraw let you
create the ovals, rectangles, lines, and
polygons that make up drawings. Every
object is formed with the current line and
fill patterns, but can be modified after it's
created if the desired patterns weren't in
use when the object was drawn. New
objects are automatically placed in front of
all other objects as they're created.

Drawing Lines

TopDraw lets you
draw two different
types of lines:
horizontal/vertical
lines, which are
drawn as if on an
invisible horizontal
or vertical axis; and
diagonal lines,
which can be at any
angle to the invisible
horizontal and
vertical axes.

Drawing
Horizontal/

Vertical Lines

@ Click the
horizontal/vertical
line tool in the tool
palette.

The tool appears
highlighted in the tool
palette, indicating that
it's the currently
selected tool, and the
pointer changes to a
crossbar pointer.

‘- File Edit View Arrange Font Style Options Windows

ntitled

44 Chapter Three




e T s T e T e S

@ Move the pointer to
the place in the
document where you
want the line to begin
and press the mouse
button.

® Holding down the
mouse button, drag the
pointer to the place in
the document where
you'd like the line to end
and release the mouse
button.

If you drag the mouse
horizontally, a horizontal line
appears in the document
window; if you drag the
mouse vertically, a vertical
line appears in the document
window.

45 Using TopDraw

To edit a line after you've
created it, click the arrow
pointer tool and use it to
select the line. Handles will
appear at the endpoints of the
line, which you can then
drag to increase or decrease
the length of the line.



Drawing Lines

@ cClick on the line tool
in the tool palette.

The tool appears highlighted
in the tool palette, indicating
that it's selected, and the
pointer changes to a crossbar
pointer.

@ Move the pointer to
the place in the
document where you'd
like the line to begin and
press the mouse button.

® Holding down the
mouse button, drag the
pointer to the location in
the document where you
want the line to end and
release the mouse
button.

A line appears in the
document window.

You can also create
horizontal, vertical, and 45
degree angle lines with the
line tool by holding down
the shift key as you draw.
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To edit a line after you've
created it, click on the arrow
pointer tool and use it to
select the line. Handles will
appear at the endpoints of the
line, which you can then
drag in different directions to
change the length, shape,

and angle of the line.
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Adding Arrowheads to Lines

You can draw lines with arrowheads on either or both
endpoints using the arrowhead selection box. A line drawn
with the arrowhead on the left side of the arrowhead box
selected will have an arrowhead on its left side endpoint; a
line drawn with the arrowhead on the right side of the
arrowhead selection box selected will have an arrowhead on
its right side endpoint. A line drawn with both arrowheads
selected will have arrowheads on both endpoints of the line.

@ Use the arrow pointer
tool to select the line to
which you'd like to add an
arrowhead or arrowheads.

Handles appear on the
endpoints of the line,
indicating that it's selected.
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@ click on either the left B Double-click on each
side arrowhead or the endpoint of the line to
right side arrowhead on which you'd like to add
the line in the arrowhead an arrowhead.

selection box.

An arrowhead appears on
An arrowhead appears on each endpoint on which you
the specified endpoint of the | double-click.

selected line.

range Font Style Options Windows
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Drawing Rectangular Objects

There are two types of rectangular objects in TopDraw, both
of which are created with their own special tools. You can
create rectangles and squares with the rectangle tool; using
the rounded rectangle tool you can create rectangles (and
squares) with rounded corners.

@ Drawing Rectangles

@ Click the rectangle tool
in the tool palette.

The tool appears highlighted
in the tool palette, indicating
that it's selected, and the
pointer changes to a crossbar
pointer.
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@ Move the pointer to
the place in the
document where you'd
like to start the rectangle
and press the mouse
button.

® Holding down the
mouse button, drag the
pointer to the place in
the document where
you'd like the diagonally
opposite corner of the
rectangle to appear and
release the mouse
button.

A rectangle appears in the
document window.

To create a square using the
rectangle tool, hold down the
shift key as you draw.
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To resize or reshape the
rectangle, use the arrow
pointer tool to select the
rectangle. Handles will
appear around the rectangle.
You can change the size and
shape of the rectangle by
dragging these handles.



Drawing
Rounded
Rectangles

@ cClick the rounded
rectangle tool in the tool
palette.

The rounded rectangle tool
appears highlighted in the
tool palette, indicating that
it's selected, and the pointer
changes to a crossbar
pointer.

@ Move the pointer to
the place in the
document where you'd
like the rounded
rectangle to begin and

press the mouse button.

® Holding down the
mouse button, drag the
pointer to the place
where you want the
diagonally opposite
corner of the rectangle to
appear and release the
mouse button.

A rounded rectangle appears
in the document window.

To constrain a rounded
rectangle to a rounded
square, hold down the shift
key as you draw.

To resize a rounded

rectangle, use the arrow

pointer tool to select it.
Handles will appear
around the rounded
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rectangle, which you can
then drag to change its
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@ Adjust the corner
radius of the rounded
rectangle until it has the
desired curvature.

You can change the
roundness of the corners of a
rounded rectangle (or, for
that matter, of a rectangle) —
the corner radius of that
rounded rectangle — by
choosing the Corner Radius
command from the Edit
Menu. When you choose
the Corner Radius
command, all rounded
rectangles drawn after
changing the corner radius
will use the new corner
radius.

To change the corner radius
of an existing rectangular
object, select that object and
then choose the Corner
Radius command. After
editing the corner radius with
the scroll bar, any selected
rectangular objects will
change to the new corner
radius. For more
information on this
command, see "Corner
Radius" in Chapter Four,
"TopDraw Reference."
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Drawing Round Objects @ Drawing Ovals
and Circles

There are two types of round objects in TopDraw: ovals (and | @ Click the oval tool in
circles, which are a special type of oval), and arcs, which are | the tool palette.
portions of ovals. TopDraw provides you with special
drawing tools to create both types of objects. The oval tool becomes
highlighted in the tool palette,
indicating that it's selected,
and the pointer changes to a
crossbar pointer.
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@ Move the pointer to
the place in the
document window where
you'd like the oval to
begin and press the
mouse button.

® Holding down the
mouse button, drag the
pointer until an oval with
the shape and size you
want appears in the
document window.
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@ Release the mouse
button.

An oval appears in the
document window.

To constrain the oval to a
circle, hold down the shift
key as you draw.

To resize or reshape the
oval, use the arrow pointer
tool to select it. Handles will
appear around the oval,
which you can then drag to
change its size and shape.



Drawing Arcs

@ Click the arc tool in
the tool palette.

The arc tool appears
highlighted in the tool
palette, indicating that it's
selected, and the pointer
changes to a crossbar
pointer.

@ Move the pointer to
the place in the
document window where
you'd like the starting
point of the arc to begin
and press the mouse
button.

® Drag the pointer to
the place in the
document where you'd
like the endpoint of the
arc to appear.

The direction in which you
drag will determine the
curvature of the arc.

ntitled
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@ As you drag the
mouse, watch the arc
change in size and
shape; when it has the
form you want, release
the mouse button.

The arc appears when you
release the mouse button.

To constrain an arc to a
quarter-circle, hold down the
shift key as you draw.

To change the number of
degrees an arc spans, select
the arc and choose the Edit
Arc Angles command from
the Edit Menu. Handles will
appear on the endpoints of
the arc. By dragging either
of these handles, you can
change the number of
degrees that the arc spans.

To resize and/or reshape the
arc, use the arrow pointer
tool to select the object.
Handles will appear around
the arc, which you can then
drag to change the size and
shape of the arc.
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m Adding
Arrowheads

to Arcs
You can use the arrowhead @ Use the arrow pointer @ Click on either or
selection box to draw arcs tool to select the arc to both of the arrowheads
with arrowheads on their which you wish to add an on the line in the
endpoints. Any arc drawn arrowhead or arrowhead selection box
with either left side or the arrowheads. to add arrowheads to the
right side arrowhead selected selected arc.
will have an arrowhead on Handles appear around the
that respective end. You can | arc, indicating that it's Arrowheads appear at the
also add arrowheads to selected. specified endpoint(s) of the
previously drawn arcs, by selected arc.

following these steps:
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@ sSelect the arc with
the arrow pointer tool.

Handles appear around the
arc, indicating that it's
selected.

@ Choose Edit Arc
Angles from the Edit
Menu.

Handles appear on the
endpoints of the arc,
indicating that it's selected
and ready to be edited.
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® Double-click on each
endpoint of the arc to
which you'd like to add
an arrowhead.

An arrowhead appears on
each endpoint of the selected
arc on which you double-
clicked.



Drawing Free—Form Shapes

There are two types of free—form objects in TopDraw —
polygons and freehand shapes — both of which are created
with their own special tools. Polygons are geometric shapes
which have a number of vertices, or angle points; you create
polygons by clicking the mouse each time you want to
specify a vertex. A freehand shape appears to be the sort of
shape you'd draw with a pen or paintbrush — freehand
shapes can have any combination of curves, lines, and
angles. In reality, however, TopDraw regards freehand
shapes as if they were polygons with a greater number of
vertices than polygons you create with the polygon tool.
Whereas you specify each vertex with a mouse click when
you create a polygon, TopDraw treats each point of a
freehand shape as a vertex. This means you don't have to
specify vertices when drawing these freehand objects, which
creates the illusion that you're drawing them "freehand."
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Drawing Polygons

@ click the polygon tool
in the tool palette.

The tool appears highlighted
in the tool palette, indicating
that it's the currently selected
tool, and the pointer changes
to a crossbar pointer.



@ Move the pointer to
the place in the
document where you'd
like to start the polygon
and click the mouse
button.

The place where you click
becomes the first point in the
polygon.

® Drag the pointer to
the place in the
document where you'd
like the next point of the
polygon to appear and
click.

As you drag the pointer, a
line forms between the first
point of the polygon and the
pointer. When you click the
mouse button, the place
where you click becomes the
second point of the polygon.

@ Drag the pointer to
the place in the
document where you'd
like the next point of the
polygon to appear and
click.

The next point of the
polygon appears in the place
where you click the mouse
button.
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® Continue dragging
the pointer and clicking
in the places where you
want the points of the
polygon to appear until
the polygon is finished.

You may add as many
vertices as your polygon
requires.

® To end the polygon,
click directly on top of
the starting point, or
double-click any other
point, or click anywhere
outside the document
window.

To constrain the lines of the
polygon to 45 or 90 degree
angles, hold down shift as
you draw.
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To resize a polygon, select it
with the arrow pointer tool.
Handles will appear around
the polygon, which you can
drag to change the size and
shape of the polygon. You
can also select the object and
then choose the Edit Polygon
Points command from the
Edit Menu; this will cause a
handle to appear on each
point of the polygon. You
can then drag each of the
handles individually to more
accurately reshape the

polygon.



Drawing Freehand
Shapes

@ Click the freehand
shape tool in the tool
palette.

The tool appears highlighted
in the tool palette, indicating
that it's selected, and the
pointer changes to a crossbar
pointer.

@ Move the pointer to
the place in the
document window where
you'd like to start the
freehand shape.

® Drag the pointer to
form the shape that you
want and release the
button.

To resize and/or reshape the
freehand object, click on the
arrow pointer tool and select
the object. Handles will
appear around the object,
which you can drag to
different locations to modify
the shape. You can also
select the object, then choose
the Edit Polygon Points
command from the Edit
Menu; this will cause a
handle to appear on each
point of the shape. You can
then drag each of the handles
individually for greater
accuracy in reshaping

the freehand object.
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At
Arrowheads to

Open Objects

An open object is an object
which has two endpoints; the
interior of the object is thus
open to the drawing area.
An object can appear to be
closed when it is actually
open — this will happen, for
example, if you create an
open object and then edit it
by placing one endpoint on
top of another. However, an
object that is created as open
will always remain an open
object, and an object that is
created closed will always
remain a closed object.

Because it's possible to
create polygons, arcs, and
freehand shapes that are
open objects, TopDraw
allows you to add
arrowheads to the ends of
such open shapes. Only
open objects can have
arrowheads; closed objects
cannot.

@ Use the arrow pointer
tool to select the open
object.

Handles appear around the
object, indicating that it's
selected.
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@ click on either one or
both of the arrowheads
on the line in the
arrowhead selection
box.

An arrowhead will appear at
the specified endpoint(s) of
the selected open object.



OR

@ select the
appropriate open object
with the arrow pointer
tool.

Handles appear around the
object, indicating that it's
selected.

@ Choose Edit Polygon
Points (if you have a
polygon selected) or Edit
Arc Angles (if the
selected object is an arc)
from the Edit Menu.

Handles appear at the
vertices of the object,
indicating that it's ready to
be edited.

@ Double-click on either
or both of the endpoints
of the object(s).

Arrowheads appear at the
endpoint(s) of the object that
you double-click.

Edit Polygon Points appears
dimmed on the Edit Menu
unless a polygon is selected;
likewise Edit Arc Angles
appears dimmed unless an
arc is selected.
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Text

Unlike the text in a word processing program, text objects in
TopDraw are independent of each other. Text objects are
treated as special objects in TopDraw; while they may be
manipulated like other objects, and can be edited in many of
the same ways, they can also be edited in some unique
ways. You can change the font, style, and size of text
objects, either existing objects or objects you are currently
creating. The color of the text and the pattern of the text
object may also be changed, but only on completed text
objects, not on objects you are currently creating.
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Creating a
Text Object

@ Click the text tool in
the tool palette.

The text tool becomes
highlighted in the tool palette,
indicating that it's the
currently selected tool, and the
pointer changes to an I-beam
pointer.



@ Position the I-beam at
the place in the
document where you'd
like the text to begin and
click the mouse button.

A blinking vertical line —
the insertion point —
appears at the place where
you clicked the mouse
button.

want to add to your
document.

® Type the text that you

@ When you're finished
typing your text, click the
I-beam anywhere else on
the screen, select
another tool, or press
return to complete the
text object.

You can add text to a
completed text object by
selecting the text, clicking
the insertion point at the
place in the text object where
you'd like to continue the
text, and typing the new text.
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Changing the
st Font of Text
Objects

@ Use the arrow pointer
tool to select the text
object you wish to
change.

Handles appear around the
object, indicating that it's
selected.

@ Choose the new font
from the Font Menu.

The selected text changes to
the new font.

You can also change the font
of the text you're currently
creating or editing — just
choose the font you want to
use while you're working on
the text, and it will change to
the font you specify.

Changing the
Style of Text
Objects

Style
COCOOXXTOITIIIT

@ Use the arrow pointer
tool to select the text
object you wish to
change.

Handles appear around the
object, indicating that it's
selected.

File Edit View Arranges Font Style Options Windows
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@ Choose the new style
from the Style Menu.

The selected text changes to
the new style.

You can also change the
style of the text you're
currently creating or editing
— just choose the styles you
want to use while you're
working on the text.

One unique feature of text
objects is that you can add
styles to a text object in any
combination: for example, a
single text object can be both
bold and italic, or
simultaneously underlined
and outlined.

Changing the
A 2 Size of Text
Objects

@ Use the arrow pointer
tool to select the text
object you wish to
change.

Handles appear around the
object, indicating that it's
selected.

@ Choose a new size
from the Font Menu.

Text objects are measured in
points. A point is a
typographic measurement
equal to 1/72nd of an inch.

The selected text changes to
the new point size.
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Editing Objects

Once an object has been drawn, there are a number of things
that you can do to modify, or edit, the object even further.
By changing the tool and option settings (line size, color,
pen and fill pattern, etc.) before drawing an object, of
course, you can make the necessary changes before the
object's drawn. Some editing operations, however — such
as duplicating, clearing, and reshaping objects — can be
performed only on previously drawn objects which you've
selected. This section begins, then, with an explanation of
selecting objects.
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El Selecting Objects

To edit an object in TopDraw,
you must first select it. When
an object is selected, four
small black blocks, called
handles, appear around the
object, and the pen and paint
bucket icons in the pattern
palette move to the line and fill
patterns of the object. In
addition, the check mark in
the line palette moves to the
line size of the selected object
(unless the object has a line
width created with the Line
Size command which is not
contained in the line palette).

There are a number of ways to
select an object or group of
objects.



Selecting
an Object

@ select the
arrow pointer tool
if it's not active.

%OD+H
AEENE

@ click
anywhere inside
the object or
along its border.

Handles appear
around the object,
indicating that it's
selected.

If an object has
None as its fill, you
won't be able to
click inside the
object. See
"Selecting Objects
Filled with None"
on the next page.

OR

@ select the
arrow pointer tool
if it's not active.
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@ click above or
below the object
and drag over the
object to draw a
selection box
around it.
Release the
mouse button.

Handles appear
around the selected
object.




Selecting
Objects
Filled with
None

@ select the
arrow pointer tool
if it's not active.

%OD+H
&0

@ click
anywhere along
the border of the
object.

Handles appear
around the object,
indicating that it's
selected.

OR

@ Select the
arrow pointer tool
if it's not active.
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@ Click above or
below the object
and drag over the
object to draw a
selection box
around it.
Release the
mouse button.

Handles appear
around the selected
object.




Selecting
Multiple
Objects

@ select the -
arrow pointer tool
if it's not active.

@ click above or
below the
grouped objects
to be selected
and drag over the
objects to draw a
selection box
around them,
making sure to
include in the
selection box the
entire boundary
of each of the
objects that you
want to select.

@ Release the
mouse button. °

Handles appear
around each of the
objects selected.

Any edits you make

will be made to all

the selected objects.
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OR

@ select the
arrow pointer tool
if it's not active.
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@ click the first
object that you
want to select.

® Hold down the
shift key.

@ One by one,
click the other
objects that you
want to select.

Handles appear
around each of the
objects as you select
them, indicating that
they're selected.
Any edits you make
with more than one
object selected will
be made to all
selected objects.
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® Release the
shift key.




Deselecting an
Object While
Others Remain
Selected

@ Hold down the shift
key.

@ click on each object
that you want to
deselect.

The handles around each
object disappear as you
deselect it, indicating that the
object's no longer selected.

Clicking (with shift held
down) an object again will
reselect it.
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Selecting All
Objects in a
Document at
Once

B Choose Select All from
the Edit Menu or press
GA.

Handles appear on all objects
in the document, indicating
that they're all selected.



Changing an
Object's Line
Pattern

@ Use the arrow pointer
tool to select the object
to be changed.

Handles appear around the
object, indicating that it's
selected.

@ Choose a new line
pattern by dragging the
pen icon to another
pattern in the pattern
palette, or click the left
side of the pattern box of
the desired pattern.

The line pattern of the object
changes to the new pattern.
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You can't drag the pen icon
to the None pattern. To
draw an object with no
border, select the dotted line
in the line palette.
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Changing an
Object's Fill
Pattern

@ Use the arrow pointer
tool to select the object
to be changed.

Handles appear around the
object, indicating that it's
selected.

@ Choose a new fill
pattern by dragging the
paint bucket icon to
another pattern in the
pattern palette, OR

click the right side of the
pattern box of the
desired pattern.

The fill pattern of the object
changes to the new pattern.

If you drag the paint bucket
icon to the None pattern, the
object will have no fill, and

will appear transparent.
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........... Changing
an Object's

Line Size

@ Use the arrow pointer
tool to select the object
to be changed.

Handles appear around the
object, indicating that it's
selected. The check mark on
the line palette moves to the
line size of the object (unless
the object's line size is a non-
standard one created with the
Line Size command and is
therefore not in the line
palette).

@ choose a new line
size by selecting a
different size in the line
palette.

The thickness of the lines of
the selected object changes to
the new line size.

OR

@ Use the arrow pointer
tool to select the object
to be changed.

Handles appear around the
object, indicating that it's
selected. The check mark on
the line palette moves to the
line size of the object.

=[1=————————Intitled

.,f' :~.\l
-~ “a
ol
HeeeV——————Ihe—————JaH
i
M
fell |

78 Chapter Three



@ Choose the Line Size
command from the Edit
Menu.

A dialog box appears,
allowing you to edit the size
of the selected object's lines.
The Line Size dialog box
contains a line definition box
— which lets you edit the
line size with your mouse —
as well as a sample rectangle
bordering the dialog box
which shows the size and
shape of the line as you
change it, and buttons to
confirm (OK) and cancel
(Cancel) your changes to the
line size.

The line definition box
contains a visual
representation of the
currently selected line size
(the line size of the selected
object) shown at maximum
enlargement. The sample
rectangle, on the other hand,
displays the line size and
shape at normal scale.

® Change the line size
and shape by clicking on
this representation and
dragging it to the desired
shape and dimensions.

You'll see the sample
rectangle change to show the
effects of your changes to
the line size.

@ click OK to confirm
the new line size.

The thickness of the lines in
the selected object changes to
the new line size. Clicking
Cancel cancels the operation.
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Reshaping Objects

With the exception of text objects, you can
resize and reproportion any object by using
the handles that appear around it when it's
selected. To reshape a selected object, you'll
drag the appropriate handles in the necessary
direction in the document window.

Reshaping
Using an
Object's
Handles

[M]

@ Use the arrow
pointer tool to
select the
object(s) to be
reshaped.

Handles appear
around each selected
object.
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@ Drag the
appropriate
handles in the
desired directions
to reshape the
object as you see
fit.

The object is
reshaped to the
proportions that
you've specified by
dragging its handles.



Reshaping a Polygon
or Freehand Shape
by Individual Points

@ Use the arrow pointer
tool to select the
polygon or freehand
object to be reshaped.

Handles appear around the
object, indicating that it's
selected.

@ Choose Edit Polygon
Points from the Edit
Menu or press CE.

A handle appears on each of
the individual points of the
object.

® Drag the appropriate
handles to new locations -
in the document to
change the shape of the
object to suit your
specifications.

The object is reshaped as
you move each handle.
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To Undo an Edit

The Undo command will
undo the last change made in
your document, with the
exception of changes in the
view scale and some
commands. You may want
to experiment with TopDraw
to discover what operations
can be undone under
different circumstances.

B Choose Undo from the
Edit Menu or press CZ.

The effects of the last
operation you performed are
undone.

Operations that can be
undone are:

* Using the Clear
command

* Moving any object(s)

« Stretching any object(s)

« Flipping any object(s)

» Rotating any object(s)

 Changing the fill pattern
of any object(s)

» Changing the line pattern
of any object(s)

» Changing the line size of
any object(s)

* Aligning objects

 Aligning objects to grid

« Editing of corner radius
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Working with Objects

Once you create objects, they
can be manipulated in a
number of ways: they can be
moved about in a document;
they can be duplicated; they
can be cut or copied to the
Clipboard and moved to
different documents; they
can be reshaped and resized;
they can be rearranged and
realigned to the invisible
"grid" TopDraw uses to let
you precisely align objects.

Moving Objects
in the Document
Window

@ Use the arrow pointer
tool to select the
object(s) to be moved.

Handles appear around the
selected object(s).

@ Holding the mouse
button down, drag the
object(s) to the desired
location in the
document.
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Clipboard Operations

TopDraw provides three commands on the
Edit Menu — Cut, Copy, and Paste —
which make use of the TopDraw Clipboard,
an area in memory and on disk that can
contain copies of things in a document. You
can cut or copy something in a document and
place it for temporary storage on the
Clipboard; when you wish to retrieve what
you put on the Clipboard, you just use the
Paste command to place the Clipboard
contents into the current document. This
allows you to move objects around in a
document and between documents, and to
make copies of objects and groups of objects
which can be placed into different
documents.

Cutting
Objects
from the
Document
Window

@ Use the arrow
pointer tool to
select the
object(s) to be
cut.

Handles appear
around the selected
object(s).

If no objects are
selected, the Cut
command appears
dimmed on the Edit
Menu.
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@ choose Cut
from the Edit
Menu or press
GX.

The object (or
objects) disappear
from the document
window, and a copy
of each selected
object is placed on
the Clipboard.
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Copying
Objects to
the Clipboard

@ Use the arrow
pointer tool to
select the
object(s) to be
copied.

Handles appear
around the selected
object(s).

If no objects are
selected, the Copy
command appears
dimmed on the Edit
Menu.

@ choose Copy
from the Edit
menu or press

o

The selected
object(s) remain in
the document
window, and a copy
of each selected
object is placed on
the Clipboard.

Pasting
Objects into
a Document

@ Using the
scroll bars, scroll
the document in
the document
window until you
see the place in
the document
where you want to
place the
contents of the
Clipboard.
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@ choose Paste
command from the
Edit Menu or
press (V.

A copy of the
contents of the
Clipboard is pasted
into the drawing.

If no objects have
been cut or copied to
the Clipboard, the
Paste command
appears dimmed on
the Edit Menu.



%Duplicating Objects

@® use the arrow pointer @ Choose the Duplicate
tool to select the command from the Edit
object(s) to be menu or press CiD.
duplicated.

An exact copy of each object
Handles appear around the that's selected appears in
selected object(s). front of and to the right of

the original.
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Clearing Objects
from the Document

@ Use the arrow pointer
tool to select the
object(s) to be removed.

Handles appear around each
selected object.

@ Choose the Clear
command from the Edit
Menu or press the delete
key.

The object disappears from
the document window,
without being copied to the

Clipboard.
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Arranging Objects

Once you've drawn an object, you may want
to rearrange it in relation to the rest of the
drawing. TopDraw lets you place objects on
top of one another, in object levels. This
section explains how to rearrange objects in
relation to one another — how to bring an
object to the top of a group of objects, how to
send an object to the back of a group of
objects, and how to "shuffle" up and down
one object level. This section also discusses
how to rotate, flip, group, align, and lock

Bringing
Objects to
the Front

@ Use the arrow
pointer tool to
select the
appropriate
object(s).

Handles appear
around the selected
object(s).

@ Choose Bring
to Front from the
Arrange Menu or
press Ci+.

The object is
brought to the top
object level.

objects.
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Sending
Objects to
the Back

@ Use the arrow
pointer tool to
select the
appropriate
object(s).

Handles appear
around the selected
object(s).

@ choose Send
to Back from the
Arrange Menu or
press C-.

The object is sent to
the bottom object
level.
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Shuffling
Objects Up
One Object
Level

@ Use the arrow
pointer tool to
select the
appropriate
object(s).

Handles appear
around the selected
object(s).

@ Choose
Shuffle Up from
the Arrange Menu

or press (7.

The object moves up
one object level.

Shuffling
Objects Down
One Object
Level

@ Use the arrow
pointer tool to
select the
appropriate
object(s).

Handles appear
around the selected
object(s).

@ Choose
Shuffle Down
from the Arrange

Menu or pressCil.

The object is sent to
the next lower object
level.
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Rotating
Objects

@ Use the arrow
pointer tool to
select the
object(s) to be
rotated.

Handles appear
around the selected
object(s).

@ Choose either
Rotate Left or
Rotate Right from
the Arrange
Menu.

The object rotates 90
degrees to the left or
to the right,
depending on which
command you
choose.

Flipping
Objects

@ Use the arrow
pointer tool to
select the
object(s) to be
flipped.

Handles appear
around the selected
object(s).

@ choose either
Flip Vertical or
Flip Horizontal
from the Arrange
Menu.

The object flips to a
mirror image of
itself horizontally or
vertically, depending
on which command
you choose.
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Grouping
Objects
Together

@ Using the
arrow pointer tool,
select the first
object that you'd
like to include in a
group of objects.

Handles will appear
around the object,
indicating that it's
selected.

@ Hold down the
shift key.

® One by one,
select the other
objects that you
want to include in
the same group.

Handles appear
around each object
as it's selected.

@ Release the
shift key.

o File Edit View Hrrange Font Style Options Windows
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® Choose Group
from the Arrange
Menu or press

GG.

All of the objects
that you grouped
will now be treated
by TopDraw as a
single object, and
can be manipulated
with a single set of
handles.

OR

@ Using the
arrow pointer tool,
draw a selection
box around all of
the objects that
you'd like to
include in a

group.

Handles appear
around each object
you draw the box
around.

@ choose Group
from the Arrange
Menu or press

3G.

All of the objects
that you grouped
will now be treated
by TopDraw as one
object, which can be
manipulated with a
single set of
handles.
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Aligning
Objects to
Other
Objects

[M]

@ Using the

arrow pointer tool,

select the first
object that you'd
like to align.

Handles appear
around the object,
indicating that it's
selected.

@ Hold down the
shift key.

@ One by one
select the other
objects that you
also want to align.

Handles appear
around each object
as it's selected.

You can also select
the objects by using
the arrow pointer
tool to draw a
selection box around
all the objects that
you'd like to align.

@ Choose Align
Objects from the
Arrange Menu or
press CG@.

A dialog box
appears, offering
several options for
aligning the selected
objects. The Align
Objects dialog box
contains a large
rectangle bisected by
both horizontal and
vertical lines (the
windowframe), as
well as two sample
objects — a
rectangle and an oval
— which show the
effects of the
alignment you
specify.
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You specify the
alignment you want
by clicking on the
appropriate lines on
the large
windowframe
rectangle containing
the intersecting
horizontal and
vertical lines.
Clicking on a line on
the windowframe
turns it red,
indicating that it's
selected; clicking on
it again turns it back
to black, deselecting
it. You can select
two alignments at
once by clicking on
the intersection of
two lines.



Imagine that the
windowframe
represents an
invisible
windowframe
surrounding the
selected objects.
Selecting a line on
the windowframe
tells TopDraw to
align the selected
objects to the
corresponding line
on the "invisible
windowframe."

Selecting the left
line, for example,
causes the objects to
be aligned on their
left sides; selecting
the top line aligns
the objects on their
top sides; clicking
the center vertical
line causes the
objects to be
centered according
to their vertical axes;
etc. As you select
these lines on the
windowframe, the
sample rectangle and
oval are rearranged
to show you the
effects of the
alignment you
specify.

® click on the
lines representing
the types of
alignment you
want.

The lines turn red as
you select them.

(e )

Cancel
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® Click OK.

The objects are
aligned to each other
in the manner
specified.

If you'd like to
cancel the operation
and leave the
selected objects
unaligned, click
Cancel.

Handles will appear
around each of the
objects, indicating
that they're selected.



Aligning Objects
to the Grid

The TopDraw grid is an
invisible grid divided
according to the minor ruler
divisions you specify with
the Edit Rulers command
(for more information on this
command, see "Edit Rulers"
in Chapter Four, "TopDraw
Reference"). The grid
allows you to line up objects
precisely according to the
rulers.

@ Use the arrow pointer
tool to select the
object(s) to be aligned.

Handles appear around the
selected object(s).

96 Chapter Three

@ Choose Align to Grid
from the Arrange Menu or

press Ci*.

The object is realigned and
reproportioned so that its
edges fit neatly to the nearest
grid lines, located at the
minor ruler divisions.
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Locking Objects to the
Drawing Surface

TopDraw lets you lock
objects to a document's
drawing surface, so they
can't be deleted or moved,
even when they're selected.

@ Use the arrow pointer
tool to select the
object(s) you want to lock
to the drawing surface.

Handles appear around each
selected object.
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@ Choose Lock from the
Arrange Menu or press

.

The object is locked
("glued") to the drawing
surface, and the handles of
the object are hollow,
indicating that the object's
locked. You'll be unable to
move, delete, duplicate, or
reshape the object without
unlocking it. The only
operations you can perform
on a locked object are
Unlock and Copy.



Unlocking Objects from
the Drawing Surface

@ uUse the arrow pointer
tool to select the
object(s) to be uniocked.

Hollow handles appear

around each selected object.

@ Choose Unlock from
the Arrange Menu or
press (.

The object is unlocked from
the drawing surface, and
you're once again able to
move, delete, resize, and
reshape it like other objects.
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Smoothing Polygons and
Freehand Objects

When you need to take the
rough edges off a drawing,
TopDraw lets you smooth
polygons and freehand
objects. When you smooth
an object, a smooth curve is
mapped within each vertex
(or "point") of the polygon,
causing the entire object to
appear more curved where it
had been angular.

@ Use the arrow pointer
tool to select the
object(s) to be
smoothed.

Handles appear around each
selected object.
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@ Choose Smooth
Polygon from the Edit
Menu or press Ci(.

The object is smoothed.
Curved lines take the place
of straight ones. In many
cases, the border of a
smoothed object may not
touch the handles that control
the object. To unsmooth a
polygon or freehand shape,
select the object and choose
Unsmooth Polygon from the
Edit Menu or press ©3).



Working With Entire Documents Changing the Document Size

While most of the commands in TopDraw are for TopDraw lets you control the
creating and editing objects, some commands let you number of pages of paper on
work with an entire document — and all its contents — | which a document appears when
at one time. printed. You can change the

document size from one page to a
maximum of 64 pages.
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@ choose Document
Size from the View
Menu.

A dialog box appears which
contains an eight by eight
grid of miniature pages,
which can be selected in any
rectangular pattern to specify
the shape and size of the
document. For example, a
drawing could be two pages
wide by six pages long, or
eight pages wide by four
pages long, etc. The current
drawing shape and size is
represented by the number of
highlighted pages in the page
grid.

@ Click on the pages in
the page grid which
represent the desired
size and shape of the
document.

The new drawing size is
indicated by the highlighted

pages.
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@ Click OK to confirm
the new document size.

When you print the
document, it will be printed
according to this specified
document size and shape.

If you wish to cancel the
Document Size operation,
click the Cancel button.



Changing the Document
Scale

Document scale refers to the
size of your document as it
appears in the document
window. You may choose
to "zero in" on one portion
of the document or have a
view wide enough to see the
entire document within the
document window. The
view commands allow you
to change the scale of a
document in the document
window.

To View the Document Closely

H Choose Enlarge from
the View Menu or press
G>.

The view of your document
will "zoom in" to be twice as
close as the previous one; the
objects appear enlarged to
twice their previous size
(hence the name of the
command). You can choose
Enlarge several times until
you reach maximum
enlargement (the closest
possible view of the
document).

=0

ntitled
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OR

B Choose Maximum
Enlargement from the
View Menu or press GM.

The view of your document
will be as close as TopDraw
will allow — the objects will
appear at maximum
enlargement.
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To See More of the
Document at Once

B Choose Reduce from
the View Menu or press
Ge.

The view of your document
is twice as broad as the
previous one — in other
words, the objects in the
document window will
appear only half as large.
You may choose Reduce
several times until you reach
the point at which the entire
document appears in the
document window.

OR

B Choose Reduce to Fit
from the View Menu or
press GF.

The view of your document
will be set so that the entire
document appears in the
document window at once
— the objects appear at
maximum reduction.

Returning the View to
Normal Scale

B Choose Normal Scale
from the File Menu or
press CN.

The view of your document
returns to the default
document size setting.

=0
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Editing the Colors

@ choose Edit
Colors from the
Options Menu.

A dialog box
appears. The Edit
Colors dialog box
contains two palettes
which combined
display all of the
colors currently
available (with a
grey selection frame
around the current
color). The top
palette contains the
four colors used by
TopDraw for
menus, windows,
and palettes. The
bottom palette
contains the
remaining 12 colors.

In addition, the
dialog box contains
two sets of three
vertical scroll bars:
R, G, and B, which
control the amount
of red, green, and
blue in the current
color; and H, 1, and
S, which control
the hue (color),
intensity (brightness
of the color) and
saturation (richness
of the color).

@ click on the
color you want to
edit to select it.

A grey frame
appears around the
color you choose.
The scroll bars
adjust to reflect the
characteristics of the
color.

® Edit the red,
green, and blue
values in the color
using the R, G,
and B scroll bars
OR
use the H scroll
bar to select a
color, and the |
and S scroll bars
to modify the
intensity and
saturation of the
color.

The selected color
changes to reflect the
modifications you
make with the scroll
bars.

@ Click OK to
confirm the new
colors that you've
created.

Any objects in the
document that
contain an edited
color change to
replace the old color
with the new one.

To cancel any edits
you've made and
return to your
document, click
Cancel. To cancel
your edits to the
colors but remain in
the Color Editor,
click the Revert
button; the last saved
versions of the color
palettes will appear.
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Editing the
Patterns

@ Choose the
pattern that you
want to edit from
the pattern
palette by
dragging the
paint bucket (fill
pattern) icon to
the desired
pattern or by
clicking on the
right side of the
pattern box.

@ choose Edit
Patterns from the
Options Menu.

A dialog box
appears containing a
miniature color
palette (the current
selected color is
surrounded by a
grey selection
frame), an edit grid
with a large
representation of the
current pattern, and
a sample fill area.

You can also
double-click a
pattern in the

pattern palette

to choose it
and bring up
the pattern
editor dialog
box.

® Using the
colors in the
miniature palette,
create the pattern
that you want in
the pattern edit
grid.

Click on a color in
the palette to select
the current color,
then click on the
appropriate boxes in
the edit grid to
change the
corresponding
components of the
pattern to that color.
You can use any of
the current colors
when editing a
pattern.

The sample fill area
changes as you
draw, showing how
the pattern that
you're working on
looks after each
change.
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@ cClick OK to
confirm the new
Pattern.

Any objects that
were filled with the
old pattern will now
be filled with the
new one.

To create a solid
color pattern, select
the color you want
in the miniature
palette and click
Flood.



Using Rulers

To help you make more
accurate drawings, as well as
let you measure objects and
keep track of where a
particular object is within a
document, TopDraw
provides on-screen rulers,
which can display either
metric or English
measurements.

To Show Rulers

B Choose Show Rulers
from the Options Menu or
press CR.

Rulers appear at the top and
left sides of the document
window.

To Hide Rulers

M Choose Hide Rulers
from the Options Menu or
press CR.

The rulers disappear from
the document window.
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Editing the Rulers

@ cChoose Edit
Rulers from the
Options Menu.

A dialog box
appears containing
options for creating

@ specity
whether you want
the rulers to use
Inches or
Centimeters as
the unit for major
divisions on the

® Choose the
number of minor
divisions you want
to display
between the

major divisions on
the ruler scales.

@ Click OK to
confirm your
specifications.

The custom rulers
that you've created
are displayed in the
document window,
changing the spacing
of the grid lines and
thereby affecting the
grid alignment of
objects drawn after
the rulers are

custom rulers. ruler scales.
You can have
anywhere from one
to 32 minor
divisions.
changed.
Unit=s:
@ Inches 'C:’" centimeters

Humber of minor diLisions:
O Oz O Os Os Oe @3
i D1z Oie Oz Orza Oz

o« D
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Displaying the
Ruler Lines

B Choose Show
Ruler Lines from
the Options
Menu.

The ruler lines
appear behind the
objects in the

document window.

Hiding the Ruler
Lines

B Choose Hide
Ruler Lines from
the Options
Menu.

The ruler lines
disappear from the

document window.

Turning the Grid
On

B Choose Turn
Grid On from the
Options Menu or
press Ci#.

The TopDraw grid
becomes active.

Turning the Grid
Off

B Choose Turn
Grid Off from the
Options Menu or
press Ci#.

The grid becomes
inactive.

* File Edit View Arrange Font Style Options Windows
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Restoring the
Program Defaults

B Choose Restore
Defaults from the
Options Menu.

The default settings for the
Options Menu are returned to
their state when you started
the program. The Restore
Defaults command cannot be
undone.

Changing to a Set of
Custom Defaults

@ set each of the
settings in the Options
Menu to the way you'd
like them to be when you
start up TopDraw.

Be careful with this
command, as it makes a
permanent change that

cannot easily be reverted.
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® Choose Save
Defaults from the
Options Menu.

The current Options Menu
settings become the default
settings, and will now be
active when the program
starts up or when you create
a new document.



Working with Document Files

The commands on the File Menu let you
perform the operations necessary for
managing your document files — naming
and saving documents as files on disk,
opening and closing documents, printing
documents. These commands use dialog
boxes requesting that you provide more
information about the procedure and
requiring confirmation before the command
is executed.

Opening an
Existing
Document

@ Close the
current document
by choosing the
Close command
from the File
Menu, clicking its
close box, or
pressing CK.

If you've made
unsaved changes to
your document, a
dialog box appears
to ask if you want to
save the document
before it's closed.
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@ Choose Open
from the File
Menu or press
do.

A dialog box
appears with a list of
all of the TopDraw
files and folders that
are on the current
disk.



® If the
document you
want is on another
disk, insert the
disk and then
click Disk.

You may have to
eject the current disk
if you're using a
system with only
one disk drive.

m To open a folder,
select the folder and
click Open or double-
click the folder

name.

m To close a folder,
click Close or click
the pathname

@ cClick the name
of the document
that you want to
open.

Scroll the list of
document names, if
necessary, to find
the name of the
document you want
to open. You can
scroll the list by
clicking the scroll
arrows on the box
displaying the

document name list.

displayed above the
file list.
open which file?
fDisk.2f
[ current {3t L Disk )
D Dance
B e | T
[ Close ]
3‘ [ Cancel ]
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® Click Open to
open the selected
document.

A copy of the
selected document
appears in the
document window.
Any changes you
make to the
document won't
affect the copy of the
document until you
save the changes
back to disk.

You can also open a
document by double-
clicking its name in
the document list.



Creating a New
Document

@ Close the current
document by choosing
Close from the File Menu
or clicking its close box.

If you've made unsaved
changes to your document, a
dialog box appears to ask if
you want to save the
document before it's closed.

@ Choose New from the
File Menu.

A new, empty document
with all settings specified
according to the program
defaults appears on the
desktop.
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Loading Bit-Mapped
Pictures into TopDraw

You can bring bit-
mapped pictures
from paint programs
such as PaintWorks
Plus™ and Deluxe
Paint [I™ into
TopDraw with the
Load Picture
command. Once a
bit-mapped picture is
loaded into
TopDraw, it's
treated like a bit-
mapped picture
inside a TopDraw
rectangle. The
rectangle containing
the bit-map can be
edited just like any
rectangle in
TopDraw: it can be
reshaped, resized,
and duplicated.
When you resize the
rectangle (stretch it
by dragging one of
its handles),
however, the bit-
map is stretched as
well. Think of the
bit-map object as a
painting inside a
frame: when you
stretch the frame, the
bit-map "painting" is
also stretched.

@ cChoose Load
Picture from the
File Menu.

A dialog box
appears with a list of
all of the bit-mapped
picture files and
folders that are on
the current disk.

® Click the name
of the bit-mapped
picture document
that you want to
open.

Scroll the list of
picture names, if
necessary, to find
the name of the
picture you want to
open. You can
scroll the list by
clicking the scroll
arrows on the box
displaying the

document name list.

® click Open to
open the selected
picture
document.

A copy of the
selected picture
appears in the
document window.

You can also load a
picture by double-
clicking its name in
ihe picture document
1st.

Load which Picture:
<=3 fPictures
O pay {t [ Dizk ]
B Inanimata k
Wall
Weather L e J
[ Close )]
@ L Cancel ]
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Saving Documents

Saving a document means writing a copy of a document
you've created or modified to disk. You should save
documents frequently as you work, to guarantee that you
have a copy of the most recent version of your work on
disk.

The File Menu contains two commands for saving
documents: Save and Save As. You'll use Save to save
changes to a document that's already been named and saved
to disk. You'll use Save As when you want to save the
current document without replacing the old version of the
document, or when you want to save a document under a
different name or to a different disk.
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Saving a Document

B Choose Save from the
File Menu or press CiS.

The document is saved to the
disk it was read from, writing
over the old version of the
document.

If you're saving a document
for the first time, the Save As
dialog box appears to let you
name it (see "Saving a
Document with a Different
Name or to Another Disk").
Otherwise, the only dialog
box to appear when you
choose Save is a message
telling you the name of the
document being saved to disk.
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Saving a
Document with a
Different Name or
to Another Disk

@ Choose Save
As from the File
Menu.

A dialog box
appears with a list of
documents and
folders on the
current disk and an
input bar containing
the name of the
current document.

Contains list of

@ If you want to
save the
document to a
different disk,
insert the disk
and click Disk.

You may have to
eject the current disk
if you're using a
system with one
disk drive.

® Type in a new
name for the
document, or
change the
pathname, or do
both.

When naming
documents and
folders (directories),
you'll want to be
sure to follow the
rules for naming
ProDOS files.
ProDOS filenames
must begin with an
alphabetic character
and can contain no
more than 15
characters, which
can be letters,
numbers, and

@ click Save or
press return to
confirm that you
want to save the
document.

If you've entered the
name of an existing
document, a dialog
box appears to ask if
you want to replace
the document on
disk with the one
you're saving. If
you've given the
document a new
name, a new
document is created
on the disk and its
name appears in the
title bar of the
document window.

Click to select different
disk or drive

Click to create new
directory

Click to open folder

(specify a subdirectory)

Click to close folder
(move up one directory)

Type name of document periods
documents on current path here.
A Styleware. TdS
1549 frag of S00K. [ Disk %!
b
Mew Folder
A prodes [ o
;! System C open }
L v aivs
R 4 Cinse 3
Save current document as: i Save ) j
intitled L cancel ]
/@ TopDraw format CrPICT FoFmst

Saves graphic to be used exclusively with TopDraw.
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Click to save document.

Specifies Apple standard format
for graphic interchange, to
allow you to place TopDraw
graphics in MultiScribe GS and
bit-mapped "paint programs."



Printing Documents

TopDraw offers two different ways to print
your document: Print Normal, which prints a
document with normal sizing regardless of
the current view scale; and Print Scaled,
which prints a document proportionate to the
current view scale.

If you haven't told TopDraw which printer
and printer port you're using before you start
printing, you may have to provide this
information to the program by choosing the
Choose Printer command from the File
Menu. For more information on specifying a
printer and printer port, see "Choose Printer"
in Chapter Four.

8-112 inches wide
by 14 inches tall

Printing a
Document
(Normal Scale)

International standard:

8-114 inches wide
by 12 inches tall

European standard:
8-1/4 inches wide

by 11-23 inches tall

Prints at 50% of original
size vertically

Prints at 50% of original
size horizontally and
vertically

Prints continuously,
without skipping
over page breaks

@ Choose Page @ select the
Setup from the desired page
File Menu. setup
specifications by
A dialog box clicking the
appears containing appropriate
different options for settings.
your document's
page size, special
printing effects, and
orientation when
printing.
8-112 inches wide ImageWriter
by 11 inches tall Page Setup
Dialog Box
IMAGEWRITER fFRINTER ©i.z2
Faper: @ Us Lettear
——————€ ) us Legal
€} International Fanfold
€ Ad Lattar
Frinter Effects:
condensed
1 sox reduction
——————F ] Ho Gap=s Between
orientation:
’%ﬂ [ canca  J WL ok ]

Prints vertically
on the page
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Prints sideways on the page, with the top
line across the right margin of the page




® click OK or @ Choose Print ® Select the ® click OK to
press return to Normal from the print options that confirm that you
confirm the new File menu. you'd like by want to print the
page setup. clicking the document
A dialog box appropriate according to the
appears containing settings. current settings.
various print
preferences. The print Your printer begins
preferences are printing the
saved with the document. A dialog
document, so that it box appears to tell
will always print you that TopDraw is
according to your printing your
specifications. document. You can
cancel printing at
any time by pressing
the & and . keys
ImageWriter simultaneously.
Print Dialog Box

Increases the pixel size
to improve the
appearance of color in

Uses a reduced pixel size to produce
better looking text printeuts.

your printouts.

IHHGEwRITER\ﬁeRmTEy V12

Prints text only, without Quality:

different fonts or sizes.

Prints all the pages in a

Fage range:
document, from first to last. 9 3

Prints the range of pages

ou specify.
you specify Copigs:

Prints the specified number
of copies of a document.

FPaper Feed:

E Color

Prints continuous-feed

ol lbe 66

Better Text
Better Color
Draft

Al

From:

CJ [
Automatic /O Manual

[ cancer ) [ ok F‘D

paper.

When selected, this setting uses the color ribbon
on your Imagewriter II to print in color.

Prints one sheet at a time.
Prompts you to feed each
sheet into the printer
individually.
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Printing a
Document at the
Current View
Scale
@ using the @ Choose Page ® Select the @ Click OK or
commands in the Setup from the desired page press return to
View Menu, set File Menu. setup confirm the new
the document to specifications by page setup.
the view scale at clicking the
which you'd like appropriate
to print your settings.
document.
The document
changes in the
document window,
according to the
view scale that you
specify.
LaserWriter
Page Setup
8-12 inches wide European standard: A Japanese standard:
by 11 inches tall 8-1/4 inches wide 7-1/4 inches wide
by 11-2/3 inches tall by 10-1/4 inches tall
8-1/2 inches wide
by 14 inches tall
LHSER}@ RER/APPLETALK 1.0

Faper: \D US Letter
Us Legal

arientation:

2 B

Frinter Effects:

bAm Letter
ES Letter

KPertical Sizing:

Prints vertically on the page. \

Prints sideways on the page,
with the top of document across
the right margin of the page

Hormal
Intermediate

/QD Condensed

Reduce or
Enlarge:

[ cance )| oK ]]

Smooths out the rough edges of
graphics and non-LaserWriter

fonts Smoothing?

=] Font substitutic

Substitutes fonts built into the
LaserWriter for regular fonts.

Normal vertical sizing:
80 dpi (dots per inch)
wideby 36 dpi tall

Intermediate vertical sizing:
80 dpi wide by 54 dpi tall
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Condensed vertical sizing:
80 dpi wide by 72 dpi tall

Reduces or enlarges
drawing by the percentage
you specify



® choose Print
Scaled from the
File Menu.

A dialog box
appears containing
various print
preferences.

Print Scaled will
print the document at
the specified view
scale.

Prints all the pages in a

® Select the @ Click OK to
print options that confirm that you
you'd like by want to print the
clicking the document
appropriate according to the
settings. current settings.
The print Your printer begins
preferences are printing the

saved with the document. A dialog
document, so that it box appears to tell
will always print you that TopDraw is
according to your printing the
specifications. document. You can
cancel printing at
any time by pressing
the (3 and . keys
LaserWriter simultaneously.
Print Dialog Box

document, from first to last.

Prints the range of pages

you specify. Select the
insertion point in

the input bar and type the
numbers for the first and
last pages of the range you
want to print.

Prints the specified number
of copies of a document.
Select the insertion point in
the input bar and type the
number of copies you want
to print.

Specifies that you'll feed the
paper into the LaserWriter
manually.

LHSERWRITER\(QP ETALK

ri.0

Fages: @ Al

Copies:
Faper Soupce:
@' Faper Cassette

€D Manual Feed

( Cancel

)

)|

Specifies automatic feed
from the LaserWriter's paper
cassette.
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Closing
Documents

M Choose Close
from the File
Menu or press
GK.

OR

B Click on the
document's close
box.

The document
disappears, leaving
the TopDraw
desktop empty.

If you've made
changes which
haven't been saved
when you close the
document, a dialog
box will appear to
ask if you want to
save your changes.

Quitting
TopDraw

@ Close the
current document
by clicking on its
close box or by
choosing Close
from the File
Menu.

The document
disappears, leaving
the TopDraw
desktop empty.

If you have any
unsaved changes
when you close the
document, a dialog
box will appear to
ask if you want to
save your changes.
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@ Choose Quit
from the File
Menu or press
aaQ.

The program stops
and returns to the
Apple IIGS Program
Launcher, or the
program from which
you started
TopDraw.
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The Tool Palette
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The Arrow
Pointer Tool

The tool palette contains the tools you'll use with TopDraw. Use
the arrow pointer to activate tools in the tool palette. The tool
palette can be repositioned in the document window. Place the
arrow pointer anywhere along the border of the tool palette, hold
the mouse button down, and move the palette to the desired
position. By choosing the Clean Up Windows command in the
Windows Menu, you can quickly restore the tool palette to its
original position. If you want to completely remove the tool palette
from the desktop, you may do so by choosing the Hide Tools
command from the Windows Menu.

The arrow pointer tool lets you select objects, move them, and
resize them. You select the arrow pointer tool by clicking on the
arrow icon in the tool palette. When Enable Auto-Select is chosen,
a box will appear around the arrow pointer tool icon in the Tool
Palette.

Use the text tool to add text to your TopDraw documents.

To place text into a TopDraw document, you'll create a text object
with the text tool. Select the text tool from the tool palette, and the
pointer will change to an I-beam pointer. Place the pointer at the
position in the document where you'd like to place text. If you
have the rulers displayed when the text tool is selected, alignment
markings appear in the ruler as you move the I-beam, indicating the
current relative position of the pointer in the document and allowing
you to properly position the insertion point. When you click the
mouse button, the I-beam pointer will disappear and it will be
replaced by a blinking vertical bar called the insertion point.
When you type text, it will appear at this point.

You can complete the text object by clicking the mouse pointer
elsewhere in the document, selecting another tool, or by pressing
return. Most of the commands that affect other objects also affect
text objects, but there are some limitations. The line pattern of a
text object will always be a solid color, while the fill pattern will
affect the background area behind the text. The only commands
that won't affect text objects are Edit Polygon Points, Edit Arc
Angles, Corner Radius, and the rotate, flip and Line Size
commands.
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Horizontal/
Vertical Lines

File Edit View Arrange: Font Style Options Windows

be filed on Mond

To edit a text object, select the text tool and click the I-beam on top
of the text you want to edit. The insertion point appears where you
click and lets you edit the text, as in other IIGS applications.

Any changes made to a text object will affect the entire object. For
example, if you highlight just one word of a text object and choose
Bold from the Style Menu, the entire object, not just the word that
was highlighted, would be made bold.

The horizontal/vertical line tool lets you draw lines that will always
be parallel to the edges of the document window.

To place a horizontal or vertical line in your document, you'll create
a line object with the horizontal/vertical line tool. Select the
horizontal/vertical line tool from the tool palette, and the pointer will
change to a crossbar pointer. Place the crossbar pointer at the
position in the document where you want to start the line. Next,
press and hold the mouse button as you drag the pointer to the place
where you want to end the line. You'll see the line stretch between
the starting point and the vertical or horizontal position of the
crossbar pointer as you draw. (Because the line will be either
horizontal or vertical, the pointer may be disconnected from the
actual endpoint of the line.)

124 Chapter Four



Diagonal Lines

* File Edit View Arrange Font Stule Optionz Windows J
e EeEe————————— -0

AL IR —
'fl raral d.

i 111]"-"%9‘%[11:9!

When you've positioned the crossbar on the spot where you want
the line to end, release the mouse button to complete the object.

The line tool allows you to draw diagonal lines of any angle in your
document.

File Edit View Arrange Font Style options Windows

ntitled

..... \\
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Rectangles/
Squares

]

Rounded
Rectangles

[=]

Select the line tool from the tool palette, and the pointer will change
to a crossbar pointer. Place the pointer at the position in the
document where you'd like to start the line. Next, press and hold
the mouse button to drag the pointer to the place where you want
the line to end. You'll see the line stretching between the starting
point and the crossbar pointer as you draw it. When you've
positioned the pointer on the place in the document where you want
the line to end, release the mouse button to complete the object.
You can constrain a diagonal line to either a 45 or 90 degree angle
by holding down the shift key as you draw it.

The rectangle tool allows you to draw rectangles and squares in
your document.

To create a rectangular object, select the rectangle tool from the tool
palette. The pointer will change to a crossbar pointer. Place the
pointer at the position in the document where you'd like to start one
corner of the rectangle. Press and hold the mouse button as you
drag the pointer to the place where you want the opposite corner of
the rectangle. You'll see two lines stretching from the starting point
to the horizontal and vertical positions of the cursor, and then two
other lines that complete the rectangle by stretching from the pointer
to the endpoints of the first two lines. When you've positioned the
pointer on the spot where you want the opposite corner of the
rectangle, release the mouse button to complete the object. To
create a square, hold down the shift key as you draw with the
rectangle tool.

The rounded rectangle tool lets you draw rounded rectangles and
squares.

To create a rounded rectangle, select the rounded rectangle tool
from the tool palette, and the pointer will change to a crossbar
pointer. Place the pointer at the position in the document where
you'd like to start one corner of the rounded rectangle. Press and
hold the mouse button as you drag the pointer to the place where
you want the opposite corner of the rounded rectangle to appear.
You'll see two lines, connected by a rounded corner, stretching
from just beyond the starting point to the horizontal and vertical
positions of the cursor, as well as two other lines that complete the
rounded rectangle by stretching from just inside the pointer to the
rounded endpoints of the first two lines.
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Ovals/Circles
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When you've positioned the pointer on the spot where you want the
opposite corner of the rounded rectangle to appear, release the
mouse button to complete the object. To create a rounded square
hold down the shift key as you draw with the rounded rectangle
tool.

You can create ovals and circles with the oval tool.

The best way to understand how ovals are drawn is to think of them
as invisible rectangles that contain ovals. Ovals are drawn in much
the same way as rectangles. Select the oval tool from the tool
palette, and the pointer will change to a crossbar pointer. Place the
pointer at the position in the document where you'd like to start one
"corner" of the oval to appear. Next, press and hold the mouse
button as you drag the pointer to the place where you want the
opposite "corner” of the oval. You'll see the oval stretching
between the starting point and the pointer as you move the mouse.
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When you've created the oval you want, release the mouse button
to complete the object.

To create a circle, hold down the shift key as you draw with the

oval tool.
Arcs The arc tool allows you to draw 90 degree arcs in your document.
To create an arc, select the arc tool from the tool palette. The pointer

will change to a crossbar pointer. The best way to understand how
arcs are drawn is to think of them as a quarter of an oval contained
in an imaginary rectangle. Arcs are drawn, then, in much the same
way as ovals, with the arc stretching from the starting point to the
pointer. Place the pointer at the position in the document where
you'd like to start one endpoint of the arc. Next, press and hold the
mouse button as you drag the pointer to the place where you want
the other endpoint of the arc. You'll see the arc stretching between
the starting point and the pointer as you move the mouse.
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Polygons
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When you've positioned the pointer on the spot that creates the arc
that you want, release the mouse button to complete the object.

Hold down the shift key as you draw arcs, and they will be
constrained to quarter circles.

You can change the number of degrees an arc spans by selecting the
arc, choosing the Edit Arc Angles command from the Edit Menu,
and dragging one of the handles on the endpoints of the arc.

The polygon tool lets you draw a polygon of any shape and with an
unlimited number of points.

To place a polygon in your document, select the polygon tool from
the tool palette and the pointer will change to a crossbar pointer.
Position the pointer at the place in the document where you'd like to
start the first line of the polygon. Click the mouse button and then
move the pointer to the place where you want the line to end.

You'll see the line stretching between the starting point and the
crossbar pointer as you draw it. When you've positioned the
pointer on the spot where you want the line to end, click the mouse
button to complete the first line.
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As you move the pointer, a line will stretch from the endpoint of
the first line to the pointer. Continue creating the polygon by
clicking the mouse at any point where you'd like to place a vertex.
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The polygon can be completed by double-clicking on any point,
clicking outside the document window, or by clicking on the
starting point. By holding down the shift key as you draw with the
polygon tool, its lines will be constrained to either 45 or 90 degree
angles.
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Freehand
Shapes

The freehand tool allows you to draw smooth, free-form objects in
your document.

To place a freehand shape in your document, select the freehand
shape tool from the tool palette. The pointer will change to a
crossbar pointer. Position the pointer at the place in the document
where you'd like to start the object, then drag the pointer to form
the shape that you want to create. You'll see the smooth line of the
object as you draw it.

File Edit View Arranges Font Style Options Windows
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You can complete the object by releasing the mouse button. If the
ends of a freehand shape are not connected, only the part of the
object that you actually draw will have a border. Freehand shapes
use more of TopDraw's memory than other objects do, so use them
only when they're necessary.
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The Line Palette

Arrowheads

The line palette lets you choose lines from a predefined set of line
sizes.

To pick one of the standard TopDraw line sizes, select the desired
line size with the pointer. The new line size will replace the current
line size, which is indicated in the palette by a check mark to the left
of the selected line size. No check mark will appear if the line size
has been edited with the Line Size command and doesn't exactly
match one of the predefined line sizes. (For more information on
this command, see "Line Size" in this chapter.) The lines in the line
palette appear on your screen at normal scale. Changes you make
to the line size will appear scaled according to the amount of
enlargement or reduction you're using in the document.

When you select an object, a check mark appears in the line palette
beside the line size of the object. If several objects with varying

line sizes are selected, of if the object's line size has been modified
to a line size not offered in the line palette, no check mark appears.

You can choose to have objects without borders by selecting the
dotted line in the line palette.

To move the Line Palette anywhere within the document window,
place the arrow pointer along the border of the line palette, hold the
mouse button down, and move the palette to the position you want.

By choosing the Clean Up Windows command in the Windows
Menu, you can quickly restore the line palette to its original
position.

The arrowhead selection box lets you add arrowheads to the
endpoints of lines and open objects (objects that have two
endpoints that don't overlap).

To add arrowheads to a line or open object, select the placement of
the arrowheads from the arrowhead selection box. Selecting the
left arrow will add an arrowhead to the left endpoint of your object,
selecting the right arrowhead will add an arrowhead to the right
endpoint, and selecting both arrowheads will add-arrowheads to
both endpoints.
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The Pattern
Palette

To add arrowheads to a previously drawn object, select that object
and then choose the appropriate arrowheads from the arrowhead
selection box.

o Fic Edit Fiew Arrange Font Style Options Windows
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The pattern palette lets you select the different line and fill patterns
that you use in drawing with TopDraw. By dragging the pen icon
and the paint bucket icon, you can change the line and fill patterns

2| of any object in TopDraw.

When an object is selected, the pen icon and paint bucket icon on
the pattern palette automatically move to the line pattern and fill
pattern of that object.

To move the pattern palette anywhere on the screen, place the arrow
pointer tool along the border of the pattern palette, hold the mouse
button down, and drag the palette to the position you want. By
choosing the Clean Up Windows command in the Windows Menu,
you can restore the pattern palette to its original position. If you
want to completely remove the pattern palette from the desktop, you
may do so by choosing the Hide Patterns command in the Windows
Menu. The Clean Up Windows command does not change the
visibility of the pattern palette.
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Pen icon
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Paint Bucket Icon
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The pen icon lets you select the line or border pattern for an object.
When you select an object, the pen icon will jump to the object's
current pattern or color on the pattern palette.

To select a line pattern for an object, drag the pen icon to the pattern
that you want to use, or click on the left side of the desired pattern
box. The pen icon will automatically jump to the selected pattern.

To change the line color of a previously drawn object, select that
object and drag the pen icon to the pattern you want to use or click
on the left side of the desired pattern. If you want an object without
a border, select the dotted line on the line palette.

Note: If you have more than one object selected and the border
patterns are different, the pen icon will disappear.

The paint bucket icon allows you to select the fill pattern for an
object. When you select an object, the paint bucket icon will jump
to the object's current fill pattern on the pattern palette.

To select a fill pattern for an object, drag the paint bucket icon to the
pattern that you want to use as a fill color. You can also select a fill
pattern by clicking on the right side of the desired pattern box. The
paint bucket icon will automatically jump to that pattern.

To change the fill color of a previously drawn object, select that
object and move the paint bucket icon to the pattern that you want to
use or click on the right side of the pattern box.

Note: If you have more than one object selected and the fill
patterns are different, the paint bucket icon will disappear.
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B About TopDraw...

B Desk Accessories

H New

The & Menu provides information about TopDraw and gives you
access to any desk accessories installed in the system folder of the
current startup disk.

The About TopDraw command displays a dialog box which tells
you the version number of your TopDraw program disk, as well as
the names of the authors of the program.

To return to TopDraw after viewing the About TopDraw
information, click the mouse button.

Any desk accessories installed in the system folder of the current
startup disk can be accessed from the ® Menu.

To run a desk accessory, choose it from the &€ Menu.

The File Menu contains commands that are used in file
management, as well as commands for printing documents.

The New command creates an empty TopDraw document that uses
the standard default settings. See "Save Defaults" in this chapter
for information on changing these defaults so that they'll always
begin modified to your preferences.

If there's an unsaved document in memory at the time New is
chosen, a dialog box appears to ask if you want to save the
document before opening a new one. To save your changes, click
on the Yes button, or click the No button to close your document
without saving it. If you decide not to open a new document, just
click the Cancel button and you'll return to TopDraw without
affecting your document.
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B Open...

H Close

The Open command lets you retrieve files that you've created and
saved.

When you choose Open, a dialog box appears, asking you to
choose the document that you'd like to open from a list of
documents available on the current disk. You can scroll the list by
pressing the arrows on the scroll bar. If you'd like to choose a
document from a different disk, click on the Disk button and
TopDraw will check all disks that are on-line and proceed to the
next one. To open a document from a folder, select the folder and
click the Open button. If you don't find the document there, you
may close the folder by clicking on the Close button.

Choose the document that you'd like to open by clicking it and then
clicking the Open button.

apen which file?
fDisk.2f
D current {F L Dizk )
Dance
Favor
Hews l'[ Spen :II
[ Close ]
L cancel ]

If there's an unsaved document in memory at the time Open is
chosen, TopDraw will ask if you want to save the document before
displaying the Open dialog box.

The Close command lets you close the current document.

If you try to close a document with unsaved changes, TopDraw
will display a dialog box asking if you want to save your changes
before closing the document.

Choosing Close is identical to clicking a document's close box.
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W Save

The Save command writes a copy of the current document to disk.
If you're saving a new, untitled document, a dialog box appears to
let you name the document (see "Save As" for an explanation of
this dialog box). If you give the new, untitled document the name
of a document already saved on that disk, a dialog box appears,
asking if you want the document you're saving to replace the old
document of the same name already on disk. Clicking Yes on this
dialog box saves the document under the name you specify.
Clicking No returns you to the previous dialog box to give the
untitled document another name.

When you've named and saved the document, a copy of the
document is written on disk and its name appears in the title bar of
the document window.

After you've opened or created a document and saved it, the next
time you save that document a dialog box will appear to tell you the
file is being saved.

You'll want to use the Save command when you want to save an
updated version of the current document on disk. You'll use Save
As when you want to save a changed document with a new name
while retaining the old version of the document under its existing
name or to make a backup or copy of an existing document with a
different path or document name from the original.

Save early, save often: you should save documents as you

work, to guarantee that you have a copy of the most recent version
of your document on disk.
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Bl Save As...

Save As lets you save the current document with a different name
or to a different disk.

When you choose Save As, a dialog box appears.
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@ TopDraw format PICT format

The Save As dialog box contains the name of the current disk, the
amount of space left on the disk, and a list of TopDraw documents
and directories on the disk. Documents are represented by
document icons to the left of their names, directories by folder
icons. The dialog box also contains an input bar for the document
name and radio buttons for specifying the format with which the
document is to be saved, TopDraw or PICT. TopDraw format
saves documents to be used exclusively with TopDraw. PICT
format is the Apple standard format for producing graphic
documents. You can transfer pictures you've saved in PICT format
to MultiScribe GS using the MultiScribe GS Load Picture
command or bring a document saved with PICT format into a
TopDraw document with the TopDraw Load Picture command
(PICT graphics are treated by both MultiScribe GS and TopDraw
like bit-mapped graphics).

The name in the input bar is highlighted. If you're saving a new
document, the name in the input bar is "Untitled." If you're saving
a document that has already been named and saved on disk, the
input bar contains the current document name.If you want to save
the document under a different name, enter a new name in the input
bar. When the input bar contains the document name, click the
Save button. The document is saved to disk. To cancel the
operation and return to the document window, click Cancel.

138 Chapter Four



-~ -

o~ e

-~

H Revert

B Load Picture...

B Choose Printer...

The Revert command removes all changes made since the last save
by reopening the last saved version of your document. When you
choose Revert, a dialog box appears, asking you to confirm or
cancel your choice. TopDraw will ask for the disk on which the
document was saved.

Note: Be sure you really want to use Revert before you choose it,
because Revert cannot be undone.

The Load Picture command lets you load color bit-mapped files into
TopDraw. You can use this command to load files from paint
programs, such as PaintWorks Plus and Deluxe Paint II.

When you choose Load Picture a dialog box appears listing all the
bit-mapped picture files on the current disk. Click the name of the
picture document you want to open. Click Open to load the
selected picture document. A copy of the selected picture appears
in the document window.

A bit-mapped picture loaded into TopDraw is treated like a bit-
mapped picture contained in a rectangular object and can therefore
be edited like any rectangle in TopDraw.

The Choose Printer command tells TopDraw what printer and
printer port you're using. Once you've provided these
specifications, you won't have to choose this command again until
you change your printer or the printer port you're using.

When you choose the Choose Printer command, a dialog box
appears on the screen.

Choose Frinter rri.0
Printer type: Printer port:
IMAGEWRITER i+ APPLETALK i+
LASERWRITER MODEM
O o
[ canca ] I[ oK )]
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W Page Setup...

8-172 inches by 11 inches
8-112 inches by 14 inches

International standard:
8-114 inches by 12 inches

European standard:

8-14 inches by 11-253 inches
Prints at 50% of original size
horizontally and vertically
Prints at 50% of original
size vertically

Prints continuously, without
skipping over page breaks
Prints vertically on the page
Prints sideways on the page,

with the top line across the
right margin of the page

The Choose Printer dialog box contains two lists—a printer list and
a printer port list. Click the name of the printer and printer port
you're using; scroll the lists using the scroll arrows, if necessary.

If you're using a LaserWriter, be sure to select AppleTalk as your
printer port specification.

When you've made your selection, click OK or press return. Your
specifications are saved to your TopDraw disk. Clicking Cancel
cancels the operation.

Note: When you use Choose Printers to change the specified
printer remember to follow with the Page Setup command to set the
page size correctly.

The Page Setup command lets you specify the size of the paper
you'll be printing on, whether it will be printed vertically (portrait)
or horizontally (landscape), and whether you want it printed with
"special effects,” such as 50% reduction.

When you choose Page Setup, a dialog box appears. This dialog
box differs depending on the printer drivers you've installed on the
system path (system folder) of your startup disk and the printer and
port you've chosen with the Choose Printer command (see
"Choose Printer..." in this chapter). If there's no printer driver on
your startup disk, a warning dialog box appears.

If you're using an ImageWriter printer, the following dialog box
appears. Change setup options by clicking the appropriate settings.

\;M}sgwnrrsk /PRINTER

FPapet: Us Letter
‘—‘f :' Uus Legal
———————_ 3 International Fanfold
———‘{} Ad Letter
Frinter Effects:
Condensed

1 s0% Reduction

1 Ho Gaps Between
arientation:

=a
=t ——H] L Cancel ][L oK ]]
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8-12 inches wide

The first time you choose Page Setup, the options are preset to US
Letter and vertical orientation, with no special effects. Any changes
you make to these setttings are saved when you save the document.

When you've chosen the Page Setup you want, click OK or press
return. Clicking Cancel or pressing esc cancels the Page Setup
operation and leaves your old settings intact.

If you're using a LaserWriter, a different dialog box appears.

European standard: A Japanese standard:

by 11 inches tall

8-172 inches wide

8-1/4 inches wide
by 11-2/3 inches tall

7-1/4 inches wide
by 10-1/4 inches tall

by 14 inches tall

Prints vertically on the page.

Prints sideways on the page, \

with the top of document across
the right margin of the page

Smooths out the rough edges of
graphics and non-LaserWriter
fonts

Substitutes fonts built into the
LaserWriter for regular fonts.

Normal vertical sizing:
80 dpi (dots per inch)
wideby 36 dpi tall

LHSERWRIFERfﬁPPLETHLK 1.0
Fapr: \}g Us Letter \o 4 Letter
Us Legal

BE Letter
orientation: Vertical Sizing:

Normal
Intermediate

/C) Condensed

Reduce or

Enlarge: m x

E

Printer Effects:

E Smoothing?

4] Font substitutiop®

l Cancel l 'i 0K ll

Intermediate vertical sizing:
80 dpi wide by 54 dpi tall

Condensed vertical sizing:
80 dpi wide by 72 dpi tall

Reduces or enlarges
drawing by the percentage
you specify

The first time you choose Page Setup, the options are preset to US
Letter, vertical orientation, and normal vertical sizing, with both
Smoothing and Font Substitution selected and 100% scaling. Any
changes you make to these settings are saved when you save the
document. Opening another document changes the page setup to
the settings saved with the document, or, in the case of a new
document, the default settings.
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M Print Normal...

Selecting Font Substitution causes the following font substitutions:
¢ New York becomes Times
» Geneva becomes Helvetica
¢ Monaco becomes Courier
 Shaston becomes 6 point Helvetica

All other non-LaserWriter fonts are printed as bit- mapped graphics.
If you choose to print without font substitution and you're using
LaserWriter fonts, printing time will increase. Choosing
Smoothing will speed up printing and make non-LaserWriter fonts
look better.

Selecting the condensed or intermediate vertical sizing settings in
the LaserWriter dialog box as a part of your page setup will make
the vertical ruler on your screen appear longer although objects will
not change. Using these settings, the objects in your printed
version will be compressed.

You can, however, add proportionately correct squares and circles
to a condensed or intermediate document by holding down the shift
key as you draw with the rectangle or oval tool. The circles/squares
will appear stretched vertically on your screen, but will be
proportionately accruate in the printout.

Once you've chosen the Page Setup you want, click OK or press
return. Clicking Cancel or pressing esc cancels the Page Setup
operation and leaves your old settings intact.

The Print Normal command prints a copy of the current document
according to the normal scale specifications. This setting is 1.0
(see "Normal Scale" in this chapter). If you've been working with
a reduced or enlarged version of a document, choosing Print
Normal will produce a document of normal scale without
converting the current scaled version on your screen.

If you haven't chosen a printer, the preset printer is ImageWriter
and the preset port is Printer.

If you're printing with an ImageWriter printer, the following dialog
box appears when you choose the Print command (the default
settings are those shown). Once you've selected the settings you
want, click OK or press return. Clicking Cancel or pressing esc
cancels the operation.
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Uses reduced pixel size

. | W LR Edit\View Arrange Font Style Options Windows
to produce better looking text. 2 ' = & e :

Increase pixel size for better
looking color. Prints text
exactly as it appears on screen.

IMAGEWRITER fFRINTER

Quality: \&) Better Text

Better Color

Prints text only, without (:l Draft
different fonts, sizes, Fage range:
or styles @ Al

Prints all the pages in a
document, from first to last

@ Automatic %nual

Cancel

Faper Feed:

Prints the range of pages
you specify.

Prints the specified number
copies of a document.

When selected, this setting uses
the color ribbon on your

Imagewriter to print in color. )
Prints one sheet at a time. Prompts you to feed each
Prints tractor-feed paper sheet into the printer individually.
fed continuously into the

printer.
If you're printing with a LaserWriter printer, the following dialog

box appears (the default settings are those shown below).
Prints all the pages in a
document, from first to last.

o8 [FMMEdit View Arrange Font Style Options Windows

Prints the range of pages you

specify. Select the insertion LHSERWRITERKF}KLETRLK

point in the input bar and type Pages: \) Al

the numbers for the first and

last pages of the range you From: : To:
want to print. Copies:

Faper Sodrce:

@ Paper Cassette
Manual Feed

Prints the specified number
of copies of a document.
Select the insertion point in [ Cancel
the input bar and type the
number of copies you want
to print.

Specifies that you'll feed the
paper into the LaserWriter

manually.
Specifies automatic feed from Once you've selected the settings you want, click the OK button or
the LaserWriter's paper cassette. press return. To cancel the command, click Cancel or press esc.
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B Print Scaled...

H Quit

When working with a document that has either been enlarged or
reduced, you can print the scaled version of your document by
using the Print Scaled command. Choose Print Scaled from the
File Menu while you have the reduced or enlarged version of your
document on the screen. The Print dialog box appears, allowing
you to specify how you want your document printed; this dialog
box differs depending on whether you're using an ImageWriter or
LaserWriter.

For a discussion of the Print dialog box, see "Print Normal..." in
this chapter.

The Quit command lets you quit TopDraw and exit to your startup
program—the IIGS DeskTop or the Program Launcher.

If you've made unsaved changes to the current document, a dialog
box appears, asking if you want to save the most recent version of
the current document before quitting.

On the Edit Menu you'll find the standard Apple IIGS editing
commands—Undo, Cut, Copy, and Paste. These commands make
use of the Clipboard, where cut or copied objects are stored. The
Edit Menu also includes commands for clearing selected objects. In
addition to these standard commands TopDraw contains additional
special commands for editing objects.
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H Undo

H Cut

H Copy

The Undo command lets you reverse the effects of the last change
made in a document. To undo a change, you must choose Undo
immediately after performing the change. Operations that can be
undone with the Undo command are:

Using the Clear command

Moving any object(s)

Stretching any object(s)

Flipping any object(s)

Rotating any object(s)

Changing the fill pattern of any object(s)
Changing the line pattern of any object(s)
Changing the line size of any object(s)
Aligning objects

Aligning objects to grid

Editing of corner radius

[ ] L] [ ] L[] L] L] [ ] L ] L] * [ ]

The Cut command removes selected objects from a document and
stores the selected material on the Clipboard, replacing the
Clipboard's current contents. The cut material remains on the
Clipboard until the next Cut or Copy task is performed.

This command may be used only when you've selected objects and
otherwise remains dimmed.

The Copy command allows you to place a copy of any selected
object or group of objects onto the Clipboard, replacing the
Clipboard's current contents.

The Copy command is useful when you want to use an object more
than once in the same document or select an object from one
document and place it in another. (See "Duplicate” in this chapter
for information on making multiple copies of an object or group of
objects.)

After selecting the object(s), choose Copy and the objects will be
copied to the Clipboard.
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M Paste

M Clear

B Duplicate

B Select All

The Paste command places the contents of the Clipboard into the
current document.

After you've selected and cut or copied an object or objects, use the
scroll bar to move to the area in the document where you want to
place the object(s). Choose Paste from the Edit Menu and the
object or objects will be placed in the center of the document
window.

Since text is treated as an object, it can be pasted like any other
object. However, when you cut or copy only part of a text object,
the cut or copied text must be placed onto another text object.

The Clear command lets you clear selected objects from a document
without placing them in the Clipboard.

When you choose Clear, all selected objects are deleted from the
current document. This command can be undone with the Undo
command.

The Duplicate command makes a copy of an object (or objects) and
places it in the document in front of and to the right of the selected
object. In effect, Duplicate performs a Copy command and then a
Paste command.

To use the Duplicate command, select the object or objects that you
want to make a copy of and then choose Duplicate. A copy of the
selected object will be placed on top of the old object or objects.
You can then move the new object anywhere on the screen and edit
it as you would any other object.

The Select All command lets you select all objects in a document in
one step. All selected objects are treated as one object and any
operations performed affect all the objects.
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B Edit Polygon
Points

The Edit Polygon Points command is used to change the shape of a
polygon and can only be used when a polygon or freehand shape is
selected. If an object other than a polygon or freehand object is
selected, the Edit Polygon Points command will remain dimmed.

To reshape a polygon, select the object and then choose Edit
Polygon Points. The normal object handles will be replaced by
handles for the individual points of the polygon. Use the pointer to
move the individual points on the object as you move the handles of
any object. Two lines or smoothed curves will stretch from the two
adjacent points of the point you're moving, showing you how the
finished object will look when you release the mouse button.
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B Edit Arc Angles

B Smooth Polygon

The Edit Arc Angles command is used to change the shape of a
previously created arc. This command can only be used when an
arc is selected. The curved part of the arc will move in a circular
path as you move the pointer. If Show Dimensions is selected, the
number of degrees that the arc should span will be displayed to the
right of the pointer.

The Smooth Polygon command allows you to smooth the edges of
a previously drawn polygon or freehand shape.

To smooth a polygon, select it and choose the Smooth Polygon
command. The normal polygon will be smoothed, with curved
lines replacing straight ones. In a freehand shape, the curvature of
lines will be made smoother.
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B Unsmooth
Polygon

B Corner Radius...

The best way to understand the effects of smoothing is to
experiment. Try smoothing some polygons and freehand shapes,
and soon you'll have a clear understanding of the things that
smoothing can do.

The Unsmooth Polygon command removes the effects of
smoothing from a polygon or freehand shape.

To use the Unsmooth Polygon command, select a smoothed
polygon and choose Unsmooth Polygon.

The Corner Radius command allows you to change the curvature of
the corners of any rounded rectangle. It can also be used to round
the corners of rectangles and squares.

When you choose the Corner Radius command a dialog box
appears that shows you a scroll bar and a sample rounded rectangle.
Pressing on the scroll arrow buttons controls the amount of
curvature on the corners of the sample rectangle. Move the box in
the scroll bar back and forth until the the sample rectangle has the
corner roundness you want, and then click the OK button. The
corners of any selected rectangles, whether created with the
rounded rectangle tool or not, will be changed to the roundness that
you specify, and any rounded rectangles you subsequently create
will have corners rounded according to your specifications.

Cancel

If you decide not to change the corner radius, click the Cancel
button and you'll return to TopDraw without making any changes.

Note: The sample you see in the dialog box appears on your screen
at normal scale. If you're working on an enlarged or reduced
document the roundness of the corners you see will be the scaled
version of the example rectangle in the dialog box.
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Line Size...

The Line Size command lets you edit the line size you use for
drawing objects in TopDraw. Changes can also be made to
previously drawn objects and/or lines in a TopDraw document. Use
this command to create a line size that is not contained in the Line
Size box.

.

sample rectangle
(appears at normal
scale-1.0)

line definition
box (line appears
at maximum
enlargement)

When you choose the Line Size command, a dialog box appears.
The dialog box contains a sample rectangle and a line definition
box. The line definition box contains a line that can be edited to
change the line size. The sample rectangle shows you how changes
to the line size will appear in your drawing. To create a custom—
sized line for your drawing, use the pointer to change the line in the
line definition box to the desired size. Dragging the line down,
vertically, will affect the horizontal lines of squares and rectangles,
and the top and bottom areas of circles or ovals. Dragging it out,
horizontally, will widen the vertical lines of squares and rectangles,
and the side areas of circles and ovals.

When you've defined the line size you want, click the OK button to
set your changes and return to your drawing. If you decide not to
change the line size setting, click the Cancel button and you'll
return to TopDraw without making any changes.

To change the line size of previously drawn objects, select the
object(s) you want to edit and choose Line Size. By using the line
definition box as described above, line size can be changed.

If you change the line size of an object to a non-standard size (one
not shown in the line palette), no check mark will appear in the line
palette when that object is selected.

Note: The line-size sample rectangle you see in the dialog box
appears on your screen at normal scale. If you're working on an
enlarged or reduced document, when you click OK you'll see in
your document the scaled version of the line size of the example
rectangle in the dialog box.
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B Set View...

The View Menu contains commands that let you change the actual
scale and size of your document. The enlarge commands (Enlarge,
Maximum Enlargement) reduce the size of the view screen, which
makes objects in your document appear larger. The reduce
commands (Reduce, Reduce to Fit) enlarge the size of the view
screen, making objects in your document appear smaller. The scale
size appears in the information bar at the top of your document
window. The scale factor for a document is dependent on the size
of the document.

The Set View command is used to change the view of a document
to an exact setting of your choice and to place the document
window anywhere within the total area of the document.

If you need greater control over the view scale of your document
than the reduce and enlarge commands provide, use the Set View
command to get a viewing size of your choice instead of

incrementing and decrementing the view scale one step at a time.

When you choose the Set View command, a dialog box appears on
the screen.
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B Reduce to Fit

B Reduce

The Set View dialog box contains a gray rectangle, which
represents the document window. The red lines represent the pages
in your document. To change the view scale, click the arrow
buttons on the scroll bar. This will enlarge or reduce the document
window. Move the document window anywhere within the
document by dragging the rectangle to the desired position.

After your changes are made, click the OK button to return to
TopDraw. If you decide not to make changes to the view scale,
click the Cancel button and you'll return to TopDraw without
affecting your document.

The Reduce to Fit command is used to change the view of a
document so that the entire document will be displayed in the
document window. This command lets you see the document at the
largest possible scale value depending on the size of the document.

The Reduce command is used to make the size of the document
window larger, to allow you to see more of the document at one
time.
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B Normal Scale

W Enlarge

When you choose the Reduce command, the view of the document
"zooms out" one step. If you use the Reduce command again, the
view will zoom out another step, unless you've reached the smallest
scale. (See "Reduce to Fit", in this chapter.)

If you need even more control over the view of your document, use
the Set View command.

The Normal Scale command is used to return the view of your
document to TopDraw's default setting, 1.0.

The Enlarge command is used to make the view of your document
larger, allowing you to see more detail of the document.

When you choose the Enlarge command, the view of the document
"zooms in" one step. If you use the Enlarge command again the
view will zoom in another step, unless you've reached the point of
maximum enlargement, which is the most detail that TopDraw can
produce (see "Maximum Enlargement" in this chapter).
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If you need more precise control over the view of your document,
use the Set View command.

153 TopDraw Reference



H Maximum
Enlargement

B Document Size...

The Maximum Enlargement command is used to change the view of
the document to its maximum size. Expressed as numbers in the
information bar, this view scale is 0.25.

To zoom in as far as TopDraw will allow, choose the Maximum
Enlargement command and the view of the document will zoom in
to show the most detail that TopDraw can produce.

The Document Size command allows you to adjust the number of
pages your document occupies.

When you choose the Document Size command, a dialog box
appears that contains an eight page by eight page grid representing
the total number of pages (64) available in the document. Each cell
in this grid represents one page of your document. The size of
your page is determined by the page setup you've chosen (see
"Page Setup" in this chapter). The pages currently being used by
your document are highlighted on the grid.

Y
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By placing the pointer on the currently highlighted pages in the grid
and moving the pointer (with the mouse button held down), you
can adjust the number of pages that your document will use. Any
highlighted pages in the grid will be included in the document.
When you've adjusted the document size, click the OK button and
you'll return to TopDraw. If you decide not to adjust the document
size, click the Cancel button and you'll return to TopDraw without
making any changes.

Changing the number of pages in a document may affect the view
scale for the reduce commands. As the document size increases,
greater reduction is necessary to include the entire document in the
viewing window.
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M Bring to Front

M Send to Back

N Shuffle Up

B Shuffle Down

The Arrange Menu contains commands that allow you to manipulate
objects in special ways. Using these commands you can move,
rearrange, rotate, flip, group or ungroup, lock and unlock, and

align objects in your document.

The Bring to Front command lets you move selected objects or
groups of objects in front of all other objects in a TopDraw
document.

Select an object or group of objects and choose the Bring to Front
command. The object(s) you've selected will move to the front of
all other objects in the document.

If you bring a grouped selection to the front, the objects in the
group will maintain their stacked relationship to each other.

The Send to Back command lets you move selected objects or
groups of objects behind all other objects in your document.

Select an object or group of objects and choose Send to Back. The
object will move behind all other objects in a TopDraw document.

If you send a grouped selection to the back, the objects in the group
will maintain their stacked relationship to each other.

The Shuffle Up command lets you move an object up one object
level in the document.

Select the object and choose Shuffle Up and the object will move up
one object level in your TopDraw document. You may need to use
Shuffle Up several times to achieve the arrangement you want.

The Shuffle Down command lets you move an object or group of
objects down one object level in a document.

Select the object and choose Shuffle Down, and the object will
move down one object level in your document. You may need to

use Shuffle Down several times to achieve the arrangement you
want.
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H Rotate Left

H Rotate Right

B Flip Horizontal

The Rotate Left command lets you rotate an object 90 degrees about
its center, to the left.

Select the object or object group you want to rotate and then choose
Rotate Left. You can use Rotate Left as many times as is necessary
to achieve the rotation that you want.

The Rotate Right command lets you rotate an object 90 degrees
about its center, to the right.

Select the object or object group you want to rotate and choose
Rotate Right. You can use Rotate Right as many times as is
necessary to achieve the rotation that you want.

The Flip Horizontal command lets you flip an object around its
horizontal center.

Select the object or object group and choose Flip Horizontal.
Objects appear flipped from side to side as a mirror image.
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W Flip Vertical

The Flip Vertical command lets you flip an object around its vertical
center.
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Select the object or object group you want to flip and choose the
Flip Vertical command. Vertically flipped objects appear upside
down and backward.
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B Group

The Group command lets you attach objects together to make a
single object. Creating an object group allows you to manipulate
objects more efficiently.

Select the objects you'd like to connect and choose the Group
command. The objects will become a single object, with only one
set of object handles. Anything you do to a single object you can
do to a grouped object, with the exception of edits, which can only
be performed on particular types of objects (see "Edit Arc Angles"
and "Edit Polygon Points"under "Edit Menu" in this chapter).
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Objects maintain their stacked relationships when they are grouped.
The objects in a group can be manipulated using the commands in
the Arrange Menu. Grouped objects are treated as a single object
and may be grouped with any other object or object group.
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B Ungroup

M Lock

B Unlock

H Align to Grid

The Ungroup command lets you break a selected group into its
component objects.

To ungroup an object group, select that group and then choose the
Ungroup command. The objects will separate and you'll be able to
manipulate them as individual objects.

If you ungroup an object composed of groups, the component
groups maintain their grouped status.

The Lock command lets you "glue" an object to the document so
that it cannot be moved.

Select the object you want to affix to the drawing surface and
choose the Lock command. The object will stay in that position on
the document until you Unlock and move it.

Locked objects can only be selected, copied to the Clipboard, and
unlocked.

The Unlock command lets you unlock an object locked to the
document with the Lock command.

To "unglue" an object from the drawing surface, select the object
and choose Unlock. The object will be unlocked and you'll be able
to manipulate it like any other object.

The Align to Grid command lets you automatically move an object
so that its boundaries are aligned with the lines of the current grid
(ruler settings) setup.

Note: The Align to Grid command may resize an object so that its
boundaries line up with the grid.
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H Align Objects...

If you've changed the alignment grid or drawn objects without the
grid and would like to align them to the current grid setting, select
the objects that you want to align and choose Align to Grid. The
objects will be moved (and resized if necessary) so that they line up
with the current grid lines.

The Align Objects command allows you to accurately align selected
objects.

To align two or more objects to each other, select the objects and
choose the Align Objects command. A dialog box containing an
alignment box and two sample objects will appear. The alignment
box consists of two sets of lines. The outer lines of the box
represent top, bottom, right and left alignment. The two lines
inside the box represent horizontal center and vertical center. Click
on any combination of the lines in the alignment box to activate
them. When selected, they appear red. The sample objects
illustrate the selected alignment to give you an idea of the effect.
You can choose more than one type of alignment at a time, although
some types of alignment remove the effects of other types.

I ComaD

When you've selected the type of alignment that you like, click on
the OK button, or press return and the objects will be aligned. If
you decide not to align the objects, click the Cancel button or press
esc.
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Style Menu

The Font Menu lets you choose fonts for selected text objects or for
text objects to be typed in at the insertion point. The preset font is
Geneva.

When you choose a font, a check mark ") appears beside that font
on the Font Menu. If you select a text object, the font of the
selected text object is the chosen font and appears checked on the
Font Menu.

When you cut or copy text objects, the text object retains its font
along with its size and style.

The Style Menu contains options for changing the style of text,
allowing you to choose a style for selected text objects or for
creating text objects. The preset style is Plain.

When you choose a style, a check mark (V) appears beside the style
on the Style Menu. You can choose a combination of styles. As
each new style is chosen, it appears checked on the Style Menu.
The only style which can't be used in combination with other styles
is Plain, which removes all other styles.

You can deselect a style by choosing the checked style again.

The Style Menu also contains options for changing the point size of
text in text objects. The preset font size is 12 point.

When you choose a font size, selected text objects or text used to
create text objects is automatically changed to the specified point
size and the chosen size appears checked on the Style Menu.

When you cut or copy text, it retains its size as well as its font and
style.
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Options Menu -

H Edit Colors...

The R, G, and B scroll bars —

let you edit the current color
selection by blending
varying amounts of red (R),
green (G), and blue (B).

The 12-color palette

The Options Menu contains various commands that let you change
settings and edit features of TopDraw.

The Edit Colors command lets you change the colors that are used
to create the pattern palette.

When you choose Edit Colors, the TopDraw Color Editor appears.

The system color palette displays the colors used
by TopDraw for menus, windows, and palettes.

displays the non-system
colors as they will appear in
your documents.

Revert button lets you revert
to last saved versions of the
color palettes.

The H, 1, and S scroll bars
let you edit the current color
selection by changing the
hue (H) and varying the
intensity (I) and saturation
(S) of the selected hue.
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The Color Editor provides you with two different methods for
editing colors. The first, known as the RGB method, allows you

to mix varying amounts of red, green, and blue to change the
composition of a color. To do this, you'll use the R (red), G
(green), and B (blue) scroll bars on the left side of the Color Editor.
These scroll bars are arranged vertically, with the top of each scroll
bar representing placement of 100% of the scroll bar's color in the
selected color and the bottom of each scroll bar representing 0% of
the scroll bar's color in the selected color. To change a selected
color to red, for example, you'll want to drag the scroll box to the
top of the R scroll bar and the scroll boxes in G and B to the
bottoms of their respective scroll bars. When R, G, and B are all
set at maximum, the selected color changes to white; when R, G,
and B are all set at off, the selected color changes to black.

The second method for editing colors, known as the HIS method
(for hue, intensity, and saturation), lets you edit a color by varying
different characteristics of the color. The first of these, hue, is the
color itself. When you scroll the H scroll bar, the color displayed
in the selection box cycles through the current available colors.
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W Edit Patterns...

Intensity is a measure of the brightness in a color. When you move
the scroll box toward the top of the I scroll bar, the selected color in
the edit palette becomes lighter (until it becomes pure white); when
you move the scroll box toward the bottom of the I scroll bar, the
selected color becomes darker (until it becomes pure black).

The third color characteristic, saturation, is a measure of the
richness of a color, how strong or pastel a color appears. As you
move the scroll box toward the top of the S scroll bar, the selected
color becomes stronger, until it is the strongest expression of that
hue. As you move the scroll box toward the bottom of the S scroll
bar, the selected color becomes lighter, until it becomes pure gray.

To edit a color using the HIS method, first choose a color or hue by
scrolling the H scroll bar until the desired hue appears in the
selection box, then scroll the I and S scroll bars to modify the
intensity and saturation of the selected color. As you scroll the H,
I, and S scroll bars, the R, G, and B scroll bars will also be

adjusted accordingly (and vice versa).

Editing the system colors — black, white, red, and grey, placed in

a separate box above the other colors — will result in changing
TopDraw's screen colors. This set of colors is used to show the
screen, so editing them will change not only your document, but the
look of the program as well.

The Edit Patterns command lets you change the line and fill patterns
that appear in the pattern palette.

To edit a pattern, first select the pattern that you'd like to edit, and
then choose the Edit Patterns command (you can also bring up the
Pattern Editor by double-clicking on the pattern that you want to
edit). A dialog box will appear in which you'll see a colors palette,
a large eight pixel by eight pixel grid containing the pattern that you
just selected, and a sample box showing how an area filled with the
pattern might look. You'll also see a box containing the currently
selected color with a Flood button beside it.

Continue editing the pattern by selecting colors from the palette and
clicking the pixels in the grid with the selected colors. When you're
satisfied with your pattern adjustment in the sample fill area, click
the OK button and the new pattern will be placed into the pattern
palette in place of the one that you edited.

163 TopDraw Reference



B Edit Rulers...

|- pattern display box
shows a normal scale
view of the selected
pattern

pattern edit box
shows the pattern
currently being edited

flood color

color palette
contains the colors
selected in the edit
colors dialog box

To fill the entire pattern with a single color, select a color from the
palette and then click on the Flood button. Every pixel in the
pattern will be of the selected color. To copy a pattern from the
pattern palette into the pattern definition box, click on the pattern in
the pattern palette. If you decide not to change the pattern, click on
the Cancel button; you'll return to TopDraw without changing any
of the patterns.

The Edit Rulers command lets you change the measuring system
used by TopDraw's rulers and the number of minor divisions per
major division in the rulers.

Units:
@ Inches ) Gentimeters

Humber of minor diLisions:
1 Oz Os Oa Os Os @s
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When you choose the Edit Rulers command, a dialog box appears
that allows you to pick either inches or centimeters as the major
divisions on the rulers. You also have the option of choosing the
number of markings that will appear per that major division. To
change the rulers, click on the options that you want to use to create
your custom rulers. When you're finished, click OK to confirm
your choices. The changes you make will not be evident unless the
rulers or ruler lines are visible. If the grid is on, it will conform to
the minor divisions of the rulers you've set.
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B Show/Hide
Rulers

The Show/Hide Rulers command operates like a toggle switch.
Show Rulers displays rulers in the document window. Hide Rulers
removes the rulers from the document window. Only one of these
commands is active in the menu at any time.

In a new document, the rulers aren't visible, unless you've used the
Save Defaults command to change the predefined default settings.
Show Rulers can only be used when the rulers aren't visible on the

screen. Hide Rulers can only be used when the rulers are visible on
the screen.

Fileg Edit View Arrange Font Style Options Windows
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If you'd like to use the rulers to guide you in making, aligning, and
positioning objects, choose Show Rulers. Rulers will appear on
the upper and left edges of the document window, allowing you to
make accurate measurements in placing objects.

The rulers don't show up on any printed copies of your work.

They do, however, affect the view scale of your document window
by decreasing size of the document window.
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B Show/Hide
Ruler Lines

B Show/Hide
Page Breaks

The Show/Hide Ruler Lines command operates like a toggle
switch. The Show Ruler Lines command displays ruler lines in a
document. Hide Ruler Lines removes ruler lines from a document.
Only one of these commands is active in the menu at a time.

In a new document, the ruler lines are visible, unless you've used
the Save Defaults command to change the predefined default
settings.

Ruler lines can help you align objects and obtain accurate
measurements on the TopDraw screen. Choose Show Ruler Lines
and the ruler lines will appear. The ruler lines will appear behind
any objects that you've drawn, and will remain displayed in the
document window until you remove them.

The ruler lines don't show up on any printed copies of your work.

The Show/Hide Page Breaks command operates like a toggle
switch. The Show Page Breaks command displays page breaks in a
document. Hide Page Breaks hides page breaks in a document.
Only one of these commands is active in the menu at one time.

In a new document, the page breaks are visible, unless you've used
the Save Defaults command to change the predefined default
settings.

To know where the pages of paper will line up with the drawing
that you're working on, choose Show Page Breaks. The page
break lines (heavy dotted lines) will appear as a part of the drawing
area. The page break lines accurately show where the edges of the
drawing surfaces of individual pieces of paper are, allowing you to
know how to align certain objects on your drawings. The page
break lines appear drawn over objects on—screen but won't appear
on printed copies of your document.
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B Show/Hide
Dimensions

The Show/Hide Dimensions command operates like a toggle
switch. If you choose the Show Dimensions command,
dimensions of objects you're editing and moving will be displayed
on the screen. If you choose the Hide Dimensions command, you
won't see this information. One of these commands is active in the
menu at a time.

In a new document, the dimensions aren't visible, unless you've

used the Save Defaults command to change the predefined default
settings.

Show Dimensions allows you to measure sizes and distances as
you're drawing an object.

To measure distances as you're drawing an object (which is useful
for such things as diagonal lines), choose Show Dimensions and a
set of numbers will appear near your drawing tool to show you
certain measurements:

¢ When dragging a selection box, the numbers show the height
and width of the selection box.

» When drawing, resizing, or selecting most objects (not
including line objects), the numbers show the height and
width of the object.

* When drawing, selecting, or resizing a line object, the
numbers show the line's length.

* When selecting or resizing a group of objects, the numbers
show the height and width of the group.

* When drawing a polygon, the numbers show the length of
each line of the polygon as it's being drawn.

» When editing the angle of an arc, the numbers show the
number of degrees in the end of the arc line you're moving.
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B Show/Hide
Document Info

H Turn Grid On/
Turn Grid Off

The Show/Hide Document Info command operates like a toggle
switch. The Show Document Info command displays document
information. Hide Document Info removes document information
from view. Only one of these commands is active in the menu at a
time.

The information displayed in the information bar is the number of
objects in the current document, the amount of available memory,
and the current view scale of the document. In a new document,
the document information is not visible, unless you've used the
Save Defaults command to alter the "normal” settings of the
program.

The Turn Grid On/Turn Grid Off command operates like a toggle
switch. The Turn Grid On turns on the invisible grid in a
document. This command helps you align objects in your
document. Turn Grid Off turns the grid off. Only one of these
commands is active in the menu at a time.

In a new document, the grid is turned off, unless you've used the
Save Defaults command to change the predefined default settings.

The Turn Grid On command allows you to turn on the invisible
grid that helps you align objects in your drawing.

For more accurate object alignment, but less precise control over
your drawing tools, use Turn Grid On and the invisible grid will
become active. Your objects will "snap" to the next grid alignment
as you're drawing them, ensuring that they will line up more
precisely.

The spacing of the grid is determined by the smallest divisions of
the ruler, whether the rulers and rulers lines are on or off. To edit
the spacing of the grid, use the Edit Rulers command to create the
spacing you want.

Objects aligned to a particular grid spacing will not change spacing
when the grid is edited, so be sure to use the Align To Grid
command to put the objects into new grid alignment. Changing the
rulers from inch to centimeter readings automatically changes the
smallest spacing of the grid; you may have to realign your objects,
however, if you make this change.
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M Enable/Disable
Auto-Select

M Restore Defaults

The Enable Auto-Select command lets you automatically select
objects as you draw them.

Auto-select enable is indicated by a black box surrounding the
arrow pointer tool on the tool palette. To select each object as it's
drawn, choose the Enable Auto-Select command from the Options
Menu. Every object that you draw will be selected after drawing it.
This step-saving command gives you the ability to manipulate
objects as soon as they're drawn. If you hold down the option key
while Auto-Select is enabled and then draw several objects, all of
the objects will be selected when you release the option key.

If Auto-Select is disabled, you can toggle it on by holding down the
option key while drawing an object. When you release the mouse
button, the object will be selected, but auto-select will remain
disabled.

In a new document, Auto-Select is disabled, unless you've used the
Save Defaults command to change the predefined default settings.

The Restore Defaults command allows you to return all of the
program startup settings to their default values.

To restore the original settings, choose Restore Defaults and each
of the settings, including all line/fill patterns and colors, will be as
they were when you started the program, unless you've used the

Save Defaults command to change the predefined default settings.
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Bl Save Defaults

The Save Defaults command allows you to save many of the
current menu settings, line/fill patterns, colors, and other
parameters to the program disk, where they will become the
defaults used whenever the program's run. Page setup, view scale,
and document size are not saved as defaults using the Save Defaults
command.

The following options are saved by the Save Defaults command:
» All current colors

All current patterns

The current line pattern

The current fill pattern

The current print options

Show/Hide rulers status

All current ruler settings

All current page setup settings

Show/Hide ruler lines status

Show/Hide page breaks status

Show/Hide dimensions status

Show/Hide document info status

Turn Grid On/Off status

Enable/Disable Auto-Select status
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If you'd like to create your own default settings so that they will
always be active when you run the program, follow these steps:

® Run TopDraw.

@ Set your own preferences, including any colors, print
options, line/fill patterns, and settings for the
functions from the Options and Windows Menus.

® Choose the Save Defaults command.

The new default settings for the program are those that you've just
saved to disk. You can use these instructions to change the default
settings at any time.

Note: Because the Save Defaults command makes a permanent
change to your TopDraw disk, use this command only if you're
sure you want to change the existing defaults. If you need to
restore the original TopDraw defaults to your program disk, they
are listed on page 174 of this manual.
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B Show/Hide Tools
B Show/Hide Lines

B Show/Hide
Patterns

H Clean Up
Windows

Installing
TopDraw on a
Hard Disk Drive

The Windows Menu contains commands to help make the
TopDraw desktop your own custom workspace.

The Show/Hide Tools command lets you toggle between displaying
the tool palette and concealing it from view.

The Show/Hide Lines command lets you display the line palette as
part of the TopDraw desktop or conceal it from view.

The Show/Hide Patterns command allows you to toggle on or off
the visibility of the pattern palette on the desktop.

The Clean Up Windows command returns the tool, line, and
pattern palettes to their original positions on the TopDraw desktop.
When you move the tool, line, and pattern palettes, using the Clean
Up Windows command will restore the document window and any
visible palettes to their original positions on the screen specified by
the default settings.

Although TopDraw is copy-protected, it can be copied to and run
from a hard disk drive without affecting your hard drive or-any files
on it.

To use TopDraw with a hard drive, your hard drive must be
ProDOS-compatible and have ProDOS installed. Consult your
hard drive user's manual to determine whether your drive can be
configured to run under ProDOS.

Use a disk utilities program, such as the System Ultilities on the
Apple 1IGS System Disk, to create a separate directory for
TopDraw. For example, if your hard drive had the name HDI1 as
its root directory name, a good name for your TopDraw disk might
be "/HD1/TopDraw." Once you've created this directory, use the
copy file command on your utilities disk to copy the following files
to your hard drive:

* TopDraw

» TD.Defaults

Run TopDraw from your hard drive using the Program Launcher or
the DeskTop System Software, included with your Apple IIGS
System Disk.
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TopDraw Original
Defaults

Title
"Untitled"

Text
Font:
Font Size:
Font Style:

Printer Setup
Printer:
Printer Port:

Page Setup
ImageWriter
Paper Size:
Special Effects:
Orientation:

Geneva (or first font in System Folder)
12 Point (or size of first font in System Folder)
Plain

ImageWriter
Printer
LaserWriter
US Letter Paper Size: US Letter
None Orientation: Vertical (Portrait)

Vertical (Portrait) Vertical Sizing: Normal
Printer Effects: None
Reduce or Enlarge:100%

Print Specifications

ImageWriter LaserWriter
Quality: Faster Pages: All
Pages: All Copies: One
Copies: One Paper Source: ~ Cassette
Paper Feed: Automatic
Color: Unselected
Default Document Settings
Page Breaks: Displayed Line Palette:  Displayed
Ruler Lines: Displayed Line Size: 1x1 pixels (at
Grid: Off normal scale)
Enable Auto Select: Off Arrowheads: No arrowheads selected
Dimensions: Off
Information Bar:  Off Pattern Palette: Displayed
Line Pattern:  Black
Rulers: Fill Pattern: ~ White
Major Divisions:  Inches
Minor Divisions:  Eighths Tool Palette:  Displayed
Document Size:  One page Tool Selected: Arrow Pointer Tool
Scale: 1.0
Corner Radius: 20 pixels per side
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& key

Also known as the Apple or Command key and represented by both the open
apple (3) and the cloverleaf or propeller symbol ('), this key is used in
combination with other keys for executing commands.

& Menu
The first menu on the left in the menu bar, this menu displays the names of any
desk accessories you have installed on your system disk.

arc

A segment of a curved line. In TopDraw, arcs are treated as portions of ovals:
when filled with a color pattern, they appear as segments of filled ovals; when
filled with None, they appear as curved lines.

arc tool
A tool in TopDraw's tool palette used to draw arcs.

arrow pointer

One of the four types of pointers used by TopDraw. With the arrow pointer you
choose commands from the menu bar, specify option settings, click on buttons
in dialog boxes, and scroll with the scroll bar. When you move the mouse
outside the document window, the pointer automatically changes to the arrow
pointer, regardless of which tool you're currently using in the document window.

arrow pointer tool

The tool that's active when you start up TopDraw. While it's identical in
appearance to the arrow pointer, the arrow pointer tool is used to select, resize,
and drag objects in the document window, whereas the arrow pointer is used to
perform document functions such as choosing commands and scrolling.

arrowhead
Shapes in the Arrowhead Selection Box you can place on the endpoints of lines,
arcs, open polygons and open freehand shapes to indicate direction.

bit-mapped graphics

Images drawn by software which places ("maps") pixels on the screen according
to an internal "mapping” of bits in video memory locations. Bit-mapped
graphics are the type of graphics created by "paint” programs, as compared to the
object-oriented graphics of "draw" programs. See also object-oriented
drawing, pixel.

button

A small box, resembling a pushbutton, with rounded corners and a label which
appears in a dialog box. Clicking a button with the mouse confirms or cancels
an operation.
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Cancel button

A button which appears in most dialog boxes. Clicking this button cancels the
command before it's executed.

choose

To pick a command from a TopDraw menu by dragging the mouse down the
menu until the desired command is highlighted and then releasing the mouse
button. You often choose a command from a menu after you've selected
something for the command to work on.

click

To position the pointer on something and then quickly press and release the
mouse button. You click in order to choose commands and options, select the
insertion point, or to confirm or cancel an operation.

Clipboard

A place in memory reserved by TopDraw for holding objects which you cut or
copy. You can then paste the contents of the Clipboard into a different location
in the document or into a different document. See also copy, cut, paste.

close box
The small box on the far left corner on the title bar of the document window.
Clicking this box closes the document.

command

An instruction to the computer to perform some task or function; a word or
phrase on a menu that specifies a task for TopDraw to perform. You choose a
command by dragging down a menu until the command is highlighted and then
releasing the mouse button. Some commands can also be executed by
simultaneously pressing the (3 key and a character key.

corner radius

The degree of curvature of the corner of a rounded rectangle. TopDraw lets you
modify the corner radius of rounded rectangles (and "regular” rectangles) with the
Corner Radius command on the Edit Menu.

_|_ Crossbar pointer

One of the four types of pointers used by TopDraw, the crossbar pointer is used
when you draw objects other than text. When you choose any of the drawing
tools except the text tool and move the cursor into the document window, the
cursor will change to a crossbar pointer.

delete key
A key on the Apple IIGS keyboard which removes a selection or the character to
the left of the insertion point in a text object.

174 Glossary




desktop

The TopDraw desktop is the working area on your screen when you use
TopDraw; it consists of the menu bar and the empty grey area beneath it. When
you open a document, it's as if you're putting a drawing on top of your desktop.
The desktop is not to be confused with the DeskTop System software for the
Apple IIGs, which lets you perform file handling functions on a similar desktop.
See DeskTop System software.

DeskTop System software

A collection of system utilities packaged with your Apple IIGS which lets you
perform file-handling functions in the same sort of desktop environment
supported by Apple IIGS application programs. For more information, see the
Apple IIGS System Disk User's Guide.

dialog box

A box which appears on the desktop whenever you're performing an operation
which requires additional information, a choice of several options, or your
approval before proceeding. Some dialog boxes display warnings telling you
that you're trying to perform a task which can't be done or which will do
something — like destroy important information — that can't be undone.

dimmed
When a command, menu title, or dialog box option is dimmed it appears to be
faded or grey, indicating that it cannot be chosen, chosen from, or selected.

document

Anything you create at one time with TopDraw or any other Apple IIGS
application program. A TopDraw document consists of objects and page setup
information saved as a file on disk with a ProDOS filename.

document scale

The relative size of the objects in your document as they appear in the document
window. The scale may be changed by using the View Menu commands. Also
known as view scale.

document size

The number of pages of paper on which a document appears when printed at
normal scale. The document size can be changed by using the Document Size
command on the View Menu.

document window

The document window provides a window into the TopDraw drawing area. As
with other windows in IIGS application software, the document window can be
resized, zoomed, scrolled, and closed.
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double-click

To position the pointer on something and rapidly press and release the mouse
button twice. Double-clicking a disk, folder, or document name or icon in a
Save or Open command dialog box opens the directory or document associated
with that name or icon.

drag

To simultaneously press and move the mouse in order to continuously select or
move something (like an object or group of objects) or to choose a command
from a menu. The move or selection is completed when you release the mouse
button.

enter key

A key on the numeric keypad of the Apple IIGS keyboard which, when pressed,
inserts a carriage return character and can therefore be used in place of the return
key in entering carriage returns or confirming commands.

esc key
A key on the Apple IIGS keyboard which can be used to cancel some commands
(in dialog boxes) in TopDraw.

file

Any information — a graphics document, word processing document,
spreadsheet data, a directory, an application program — stored in one place unde
one name on a volume (disk, hard drive, RAM drive).

fill pattern

One of the 38 patterns (39, counting None) that can fill the interior of an object.
A fill pattern is selected on the pattern palette by dragging the paint bucket icon
to the pattern or by clicking on the right side of the pattern.

folder

A subdirectory on a volume; represented by a folder icon. Folders provide a
visual analogy for what subdirectories do — help you organize your documents
on a volume the way real folders help you organize paper documents in a file
cabinet.

font

A character set of a specific type style, including letters, numbers, punctuation
marks, and other special characters. TopDraw provides you with a variety of
fonts, located on the Font Menu, to use in creating text objects.

font size
See point size.
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freehand shape tool

The tool in TopDraw's tool palette that lets you draw freehand lines and shapes.
When the freehand shape tool is selected you can't use rulers or the grid to guide
your drawing.

grid

An invisible pattern of horizontal and vertical lines which conform to the minor
ruler divisions set in TopDraw. The grid is used to align objects and shapes
drawn in the document window. You can turn the grid on and off with the Grid
On and Grid Off commands on the Options Menu.

group
To attach a number of objects to each other (with the Group command on the
Arrange Menu) so that they may be treated as a single object.

highlight

To make something appear distinct from the rest of the document by inverting it
on the screen. Your choice is highlighted to indicate that it's selected. See also
select.

horizontal/vertical line tool
The tool in the TopDraw tool palette that lets you draw horizontal and vertical
lines that are always parallel to the edges of the document window.

I-beam

One of the four forms of the TopDraw pointer, the I-beam is shaped somewhat
like the insertion point and is used to select the insertion point in text objects
and to select text for editing, deleting, and replacing.

icon
An image that graphically represents an object, a concept, or a message.

information bar

A box at the top of the document window that indicates the current number of
objects in the current document, the amount of free memory in your computer,
and the current view scale of the current document.

input bars

Input bars are boxes in dialog boxes where you type in information requested by
the dialog box. When you click on an input bar an insertion point appears,
allowing you to type.
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insertion point
The blinking vertical bar which marks the place in a document (or an input
bar) where you type in text to create or modify a text object.

keyboard equivalents

Some TopDraw commands can be executed without going to the menu by
simultaneously pressing the (3 key and a character key. These key sequences are
called the keyboard equivalents to their respective commands on the menus.
Commands with keyboard equivalents have their keyboard equivalents displayed
to the right of the command on its menu.

landscape orientation

One of the ways you can print on the page with TopDraw. Landscape print
orientation tells TopDraw that you want to print sideways on the page, with the
top line across the right margin of the paper. Also called horizontal print
orientation. See also portrait orientation.

line palette

The rectangular area on the lower-left side of the TopDraw desktop which
displays the current line size and example lines which can be selected to change
the line size of objects.

line pattern

The selected pattern from the pattern palette used to create lines and the borders
of objects. The pen icon is moved in the pattern palette to choose the pattern or
color.

line tool
The tool in the TopDraw tool palette used to draw straight lines at any angle.

major ruler divisons
Units for major divisions on the ruler scales, displayed in either centimeters
(metric) or inches (English).

menu

A box containing a list of commands which appears when you press on its title
in the menu bar with the mouse (this is called "pulling down" the menu). You
choose commands by dragging down the menu until the command you want to
use is highlighted and then releasing the mouse button.

menu bar

The horizontal box at the top of the screen from which you pull down menus
and choose commands.
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minor ruler divisons

The number of divisions between the major divisons (inches or centimeters) on
the rulers. Minor ruler divisions can number up to 32 per major division. You
can specify the number of minor ruler divisions with Edit Rulers.

None
A box on the far left side of the pattern palette which, when selected, results in
an object with no fill pattern (a "transparent” or "hollow" object).

object level

TopDraw lets you place objects on top of one another, or overlay, objects. Each
layer in a group of overlaid objects is called an object level. You can change the
object level of a selected object with the Bring to Front, Send to Back, Shuffle
Up, and Shuffle Down commands. See also overlay.

object-oriented drawing
A method of creating graphics using mathematically defined shapes that can be
easily manipulated and combined to create pictures.

open object
Any object that when completed has two endpoints.

operation
Any drawing job performed by TopDraw; also called a task.

option key
The key on the left side of the bottom row of the Apple keyboard which can be

used in combination with other keys to perform certain tasks, such as selecting.

oval tool
The tool on the TopDraw tool palette used to draw ovals and circles.

overlay
To place one object on top of another. See also object level.

paint bucket icon
The icon that lets you choose the fill pattern for objects.

pattern palette
The palette that contains the line and fill patterns for objects created in TopDraw.

pen icon
The icon used to choose the line pattern for any object created in TopDraw.
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pixel
Short for picture element. A point on the IIGS graphics screen. In bit-mapped
graphics, the visual representation of a bit (in video memory) on the screen.

point size

The overall size of a font, measured in points. A point is equivalent to 1/72 of
an inch, so a 12 point font is equal to 1/6 of an inch. Also known as font size,
the point size of a font is actually a measurement of the overall height of the
font, as the widths of individual characters (an "1" and a "W," for example) vary
greatly. See also font.

pointer

A small shape on the screen that moves as you move the mouse. To select,
move, and edit objects, you'll use the arrow pointer tool. When you're creating
text objects, the pointer takes the form of an I-beam and can be used to select the
insertion point as well as to select text objects. While drawing objects and
shapes in the document window, the pointer is a cross beam. When you move
the pointer out of the the document window, it becomes an arrow and can be
used to choose commands from menus, select options, and drag windows. When
TopDraw performs an action which takes a few moments to complete, the
pointer changes to a wristwatch telling you to stand by for a few moments. See
also arrow pointer, arrow pointer tool, crossbar pointer, I-beam

pointer, wristwatch pointer.

polygon

A geometric figure composed of three or more lines connected end to end. (In
TopDraw, however, you can have open polygons consisting of only two
lines.) See also open object.

polygon tool
A tool on the TopDraw tool palette used to draw polygons with user-defined
vertices. See also polygon, vertex.

portrait orientation

One of the ways you can print on the page with TopDraw. Portrait print
orientation tells TopDraw that you want to print vertically on the page, with the
top line across the top margin of the paper. Also called vertical print
orientation. See also landscape orientation.

press
To place the pointer on something (such as a scroll arrow) and hold down the
mouse button to perform a continuous action.

ProDOS 16
Disk operating system for the Apple IIGS under which TopDraw operates.
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Program Launcher
A program on the Apple IIGS System Disk that lets you run application
programs.

@ rectangle tool

A tool on the TopDraw tool palette used to draw rectangles and squares.

return key

The large L-shaped key on the Apple keyboard which is used to complete text
objects or to confirm choices in dialog boxes (instead of clicking OK with the
mouse). The enter key can be used in place of the return key.

@ rounded rectangle tool
The tool on the TopDraw tool palette you can use to draw rectangles and squares
with rounded corners.

ruler lines

The grey dotted lines that appear in the document window to help in aligning
objects in a drawing. The ruler lines are displayed at the major ruler divisions.
See also major ruler divisions.

scroll’
To move a document up and down or right and left in the document window so
that you can see another part of the document.

scroll arrows
"i.:i" '{} The arrows, located on the top and bottom (or left and right) of a scroll bar,
which, when pressed, scroll the document down or up, left or right, in the

document window.

scroll bar
The rectangular panel containing a white box (the scroll box) which you drag
along the panel to reach any particular part of a document.

scroll box

The box inside the scroll bar which you drag up and down to scroll a document.
The scroll box changes size and position to reflect the amount of a document
displayed in the document window and the location of that portion in the
document.

select
To choose something to receive the next action. When an object is seleted a set
of handles appear around it.
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shift key

There are two shift keys on the Apple IIGS keyboard, one on either side of the
keyboard. Holding a shift key down as you draw with one of the drawing tools
restricts the shape that object will assume to a predefined, "regular” shape.
Holding shift down as you draw with the oval tool creates a circle; holding down
shift as you draw with the rectangle tool creates a square; etc. Holding the shift
key down while you type character keys in a text object produces the uppercase
letter or the upper character on a two-character key.

size box
A box on the lower-right corner of the document window that you can drag to
change the size and shape of the document window.

text object
An object used to add captions, titles, and text to a TopDraw document.

text tool
A tool in the TopDraw tool palette used to place text into a TopDraw document
by creating text objects. The text tool also lets you edit text objects.

title bar

The bar at the top of the document window that tells you the name of the
document. By dragging the title bar, you can move the document window
around on the screen.

tool palette
The palette that contains the tools used to draw objects in TopDraw.

vertex
The point at which the sides of an angle intersect. The plural is vertices.

view scale
The relative size of the objects in your document as they appear in the document
window; may be changed with the View Menu commands.

wristwatch pointer
One of the four types of pointers used in TopDraw, the wristwatch appears when
TopDraw performs an action which takes a few moments to complete.

zoom box

The box on the upper right corner of the document window. Clicking on the
zoom box expands the document window to its full size, until it fills the entire
screen; clicking it a second time contracts the window to its regular size.
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A
A4 Letter 37,116, 118, 140, 141
About TopDraw command 135
aligning objects
to the grid 96
to other objects 94
Apple IIGS Owner’s Manual 5
Apple IIGS System Disk 171
Apple IIGS System Disk User’s Guide 5
Apple-Key 173
Apple key commands 22
Apple Menu 135, 173
AppleMouse II 5
AppleTalk 139, 140
arc 17, 56, 128-129, 173
arc tool 17, 128-129, 173
Arrange Menu 28, 31, 88-99, 155
arranging objects 88-99
aligning 94-96
bring to front 88
flipping 91
grouping 92-93
locking 97
rotating 91
send to back 89
shuffle 90
ungrouping 93
unlocking 98
arrow pointer 123, 173
arrow pointer tool 14, 27, 30, 64, 123,
173
arrowhead selection box 19, 48, 58, 64,
132,173
arrowheads 19, 48, 58, 64, 132, 173

B

best (print quality) 38, 117, 143
bit-mapped graphics 3, 6, 173

Bring to Front command 21, 28, 88, 155
button 173

183 Index

C

Cancel button 174

changing document scale 102-103

changing document size 100-101

check mark 19, 132, 161

choose 174

choose Printer 35, 116, 139

circles 16, 54-55, 127

Clean Up Windows command 123, 132,
133,171

Clear command 145, 146

clearing objects 87

click 174

clicking 5

Clipboard 83, 84-85, 145, 146, 174

close Box 12,110, 112, 120, 136, 174

Close command 110, 111, 112, 120, 136

closing documents 120

colors 20
Edit Colors command 104, 162-163

command 174

copies input bar 38

Copy command 82, 83, 144, 145

Corner Radius command 16, 53, 123, 149

crossbar pointer 44, 46, 124, 126, 129,
131, 174

custom defaults 109

custom rulers 107, 164

Cut command 22, 82, 84, 86, 144, 145

D

defaults 109, 170, 172

delete key 174

deselecting objects 75

Desk Accessories 135

desktop 175

Desktop System Software 175

diagonal lines 125

dialog box 79, 94, 101, 116, 120, 143,
144, 150, 152, 175

dimmed 175

Disable Auto-Select command 169

document 5, 175



document info 168
Show Document Info 168
Hide Document Info 168
document scale 102, 151-154, 175
enlarge 102, 153-154
normal 103, 153
reduce 103, 152
document size 175
changing 100-101
Document Size command 101, 154
document window 11-13, 175
dot matrix printing 38
dragging 5, 176
drawing objects 44
arcs 56-57
circles 54-55
freehand shapes 60, 63
horizontal/vertical lines 44-45
ovals 54-55
polygons 60-62
rectangles 50-51
squares 50-51
diagonal lines 46, 47
drawing size 101
drawing tools 6
Duplicate command 31, 86, 146

E

editing
arcs 17,57, 128, 148
arc angles 17, 57-59, 129, 148
colors 104, 162-163
corner radius 53, 149
diagonal lines 46, 125
free hand shapes 63
horizontal/vertical lines 45, 124
line size 78,79, 150
objects 70
ovals/circles 55, 127
patterns 20, 105, 163-164
polygon 62, 124
rectangles/squares 51, 53

184 Index

text 66-69
Edit Menu 22, 31, 144-146
Edit commands
Arc Angles command 57, 129, 148
Colors command 104, 162, 163
Patterns command 31, 105, 163, 164
Polygon Points command 17, 18,
65, 147
Rulers command 22, 96, 107-108, 164
Corner Radius command 53, 149
Enable Auto-Select command 123, 169
english measurement system 22, 106
Enlarge command 151, 153, 154
enlarging the view 102
enter key 176
esc key 176

F
file 110, 135, 176

file management 110, 135

File Menu 34, 35, 135

fill pattern 20, 21, 29, 77, 133, 134, 178
Flip Horizontal command 91, 157
flipping objects 91, 123, 156-157
folders 111, 136, 176

Font Menu 68, 161, 176

font size 69, 161, 176

font substitution 141

free form shapes 18, 60, 63

freehand object 18, 131

freehand shape 6, 18, 60, 63, 131
freehand shape tool 18, 28, 63, 131, 179

G

Getting Started 4

graphics, object oriented 3, 6
graphics, bit-mapped 3, 6, 173
grid 81, 88, 96, 108, 169, 177
Group command 31, 93, 158, 177
grouping 31, 92, 158, 168

H
HIS method (color editing) 104, 162-163
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handles 15, 16, 21, 129, 147, 158

hard disk 171

Hide Document Info command 168

Hide Lines command 171

Hide Page Breaks command 166

Hide Patterns command 171

Hide Rulers Lines command 108, 166

Hide Tools command 123, 171

highlight 177

horizontal line 15, 33, 44, 124-125

horizontal/vertical line tool 15, 33, 44,
124, 179

i

I-beam pointer 14, 32, 33, 66, 123, 177

icon 14,177

ImageWriter, ImageWriter II 36, 37,
140, 142, 144

Important Terms 5

information bar 13,151, 169, 177

input bar 34, 138, 177

insertion point 32, 33, 67, 123, 178

International Fanfold 37, 118, 140

K
keyboard commands 22
keyboard equivalents 5, 22, 178

L

landscape, 37, 140, 178

LaserWriter 36, 37, 139, 141, 143

LaserWriter fonts 141

layer 21

Learning TopDraw 9

level 21, 88

line 6, 15, 46, 124, 126, 168

line palette 11, 19, 21, 24, 25,132, 172,
178

line pattern 20, 25, 76, 80, 133, 134, 178

line size 11, 19,78, 79, 123, 132, 150

line definition box 79, 150

line tool 15, 46, 124, 125,178

Load Picture command 113, 139, 144

185 Index

Lock command 97, 159
locking objects 98, 159

M

major ruler divisions 107, 164, 178

Maximum Enlargement command 102,
154

memory expansion cards 4

menu 178

menu bar 11, 178

metric measurement system 22, 106

minor ruler divisions 107, 164, 179

MousePaint 5

N

naming documents 114, 115, 137
New command 135

none 14, 20, 28, 179

Normal Scale command 103, 153

o

object 5,6

object level 21, 88, 179
object driented drawing 6, 179
object oriented graphics 3, 6
Open command 110, 136
open object 19, 64, 132, 179
opening an existing document 110
operation 179

option key 179

Options Menu 162
orientation 37, 140, 141

oval 6, 16, 127

oval tool 16, 27, 54, 127, 179
overlapping objects 21, 27
overlay 5,179

P

page breaks 166

Page Setup 36-37, 116, 140, 141

paint bucket icon 21, 25, 105, 133, 134,
181

palette
line 11, 19,21, 24,25, 132



pattern 11, 20, 25, 133, 172, 181
tool 11, 14, 123
Paste command 83, 84, 85, 144, 146
pattern editor 163
pattern palette 11, 20, 25, 105, 133, 172,
181
patterns 20, 105, 163
pen icon 20, 25, 76, 133, 134, 181
PICT format 35, 115, 138
Picture (load) command 113, 144
pixel 163, 182
point size 161, 182
pointer 123, 124, 126, 127, 128, 129,
130, 170, 182
arrow 123,173
crossbar 124-130, 174
I-beam 123, 177
wristwatch pointer 182
pointing 5
polygon 6, 17, 129, 130, 168, 180
polygon tool 17,29, 60, 129, 180
portrait 37, 140, 180
press 180
Print Normal command 37, 116, 117,
142
Print Scaled command 116, 118-119,
144
printer 35
printer port 35, 116, 139, 142
Printer Setup command 36
printing documents 35, 116, 139
normal size documents 37, 116, 117
scaled documents 118
setup considerations 36
problems with your TopDraw disk 6
ProDOS 16 5, 180
program defaults 109, 169-170, 172
Program Launcher 10, 39, 120, 144, 181
pull-down menus 5

Q
Quit command 39, 120, 144
quitting TopDraw 120, 144

186 Index

R
RAM 4
RGB method (color editing) 104, 162-163
rectangle 6, 15, 16, 24, 126,149, 150
rectangle tool 15, 24, 26, 50, 126, 181
Reduce command 103, 151, 152
Reduce to Fit command 103, 152
reducing the view 103, 152
reshaping objects
by handles 88
by individual points 81, 147
Restoring Program Defaults 109, 169
return key 181
Revert command 139
Rotate Left command 156
Rotate Right command 156
rotating objects 91, 123, 156
round objects 54
rounded rectangle tool 16, 24, 52, 126-
127,183
ruler lines 22, 108, 166, 181
show 108, 166
hide 108, 166
rulers 22,23, 106, 123, 165
Edit Rulers command 22, 164
Show Rulers command 22, 23, 106, 165
Hide Rulers command 22, 106, 165

S
Save As command 34, 115, 138
save button 34, 115
Save command 114, 137
Save Defaults command 109, 135, 170
saving documents 114, 115
scale
enlarging 102, 153-154
normal 103, 153
reducing 103, 152
scroll arrow 13, 139, 149, 152, 181
scroll bars 12, 13, 146,149, 151, 162, 181
scroll box 13, 181
select 21, 181
Select All command 75, 146



selection box 21, 167

selecting objects 21, 70-75

Send to Back 21, 89, 155

Set View command 151

shift key 27,182

Show Dimensions command 148, 167
Show Document Info command 168
Show Lines command 171

Show Page Breaks command 166
Show Patterns command 171

Show Ruler Lines command 22, 166
Show Rulers 22, 165

Show Tools command 171

Shuffle Down 21, 88, 90, 155
Shuffle Up 21, 88, 90, 155

size box 12, 13, 182

Smooth Polygon command 148
smoothing objects 99, 148
smoothing (with LaserWriter) 142
special effects 37, 140

square 15

Starting TopDraw 10

Style Menu 182

substitution (font) 141

System Requirements 4

T
technical support 6
text 6, 14, 66, 123, 145, 161
text objects 14, 66, 123, 161, 182
text tool 14, 32, 66, 123, 182
Things to Know 5
title 12
title bar 12, 35, 137, 182
tool
arc 17,56, 128,173
arrow pointer 14, 27, 30
freehand shape 18, 28, 63, 131, 177
horizontal/vertical line 15, 33, 44, 124,
179
line 15,46, 124, 125, 178
oval 16,27,54,127,179
polygon 17,29, 60, 129, 180

187 Index

rectangle 15, 24, 26, 50, 126, 181
rounded rectangle 16, 24,52, 126, 127,
181
text 14, 32, 66, 123, 182
tool palette 11, 13, 24, 28, 46, 123, 171
TopDraw desktop 11
TopDraw format 35, 115, 138
Turn Grid Off command 168
Turn Grid On command 168

u

Undo command 80, 145

Ungroup command 159

Unlock command 97, 98, 159
Unsmooth Polygon command 149
untitled 12, 34, 138

using the mouse 5

using TopDraw 6

US Letter 37, 139, 140

US Legal 37, 139, 140

Vv

version number 135

vertical lines 124

vertex 60, 130, 182

View Menu 118, 151

viewing the document 102, 103, 118
enlarge 102, 153-154
normal 103, 153
reduce 103, 152

w
Windows Menu 123, 133, 171
wristwatch pointer 182

Y B
Your Tour of the Apple IIGS 5

Z
zoom box 12, 13, 182
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